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Safety Information

The attached "Safety Precautions" manual contains important information about the safe and correct
use of the ScanSnap. Make sure that you read and understand it before using the ScanSnap.

Safety Information
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Manuals

Read the following manuals according to your needs when using the ScanSnap.

Before Using the ScanSnap
Manual Description and Location

Safety Precautions This manual contains important information about the safe use of the ScanSnap.
Make sure you read this manual before using the ScanSnap.
This manual is included in the package.

In addition, when the software is already installed, this manual can be accessed as
follows: From the sidebar in Finder, select [Applications] → [ScanSnap Manuals], and
then double-click [SV600 Safety Precautions].

When Setting Up the ScanSnap
Manual Description and Location

ScanSnap SV600 Getting
Started

This manual explains the setup procedure from the moment you open the package to
testing the operations.
Getting Started is included in the package.

In addition, when the software is already installed, this manual can be accessed as
follows: From the sidebar in Finder, select [Applications] → [ScanSnap Manuals], and
then double-click [SV600 Getting Started].

When Operating the ScanSnap
Manual Description and Location

ScanSnap SV600 Basic
Operation Guide (this
manual)

This manual explains the basic operations and cleaning procedure for the ScanSnap.

ScanSnap Advanced
Operation Guide

This manual describes operations including various scanning methods and useful
usages of the ScanSnap.
You can refer to this manual at the following website.
http://www.pfu.fujitsu.com/imaging/downloads/manual/advanced/mac/en/common/
index.html

ScanSnap Manager Help This Help file describes the windows, operational troubles and the solutions, as well as
messages of the ScanSnap Manager.
This manual can be accessed by one of the following methods:

l Click the ScanSnap Manager icon  in the Dock while holding down the
[control] key on the keyboard, and select [Help] → [Help] from the "ScanSnap
Manager Menu" (page 42).

l Click the Help button ( ) for ScanSnap Manager.
l Select [Help] in the menu bar → [ScanSnap Manager Help].

Manuals
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When Saving Scanned Images to a Mobile Device
Manual Description and Location

ScanSnap Basic Operation
Guide (Mobile Connection
for iOS)

This manual describes operations to be performed on an iOS-based mobile device
when you save scanned images to the mobile device.
This manual can be accessed by the following method:
1. Start up ScanSnap Connect Application on the mobile device.
a The [File List] screen appears.

2. Tap .
a The [Information] screen appears.

3. Tap the [Help] button.

ScanSnap Basic Operation
Guide (Mobile Connection
for Android)

This manual describes operations to be performed on an Android-based mobile device
when you save scanned images to the mobile device.
This manual can be accessed by the following method:
1. Start up ScanSnap Connect Application on the mobile device.
a The [File List] screen appears.

2. Tap .
a The menu appears.

3. Tap [Help].

When Updating the Software
Manual Description and Location

ScanSnap Online Update
Help

This Help file describes the operations, windows, and messages of ScanSnap Online
Update.
This Help file can be accessed by one of the following methods:

l Click the Help button ( ) of ScanSnap Online Update.
l Select [Help] in the menu bar → [ScanSnap Online Update Help].

When Using Related Applications
Manual Description and Location

ScanSnap Organizer Help This Help file describes the operations, windows, and messages of ScanSnap
Organizer.
This Help file can be accessed by selecting [Help] in the menu bar → [ScanSnap
Organizer Help].

CardMinder Help This Help file describes the operations, windows, and messages of CardMinder.
This Help file can be accessed by selecting [Help] in the menu bar → [CardMinder
Help].

Nuance PDF Converter for
Mac Help

This Help file can be accessed by selecting [Help] in the menu bar → [Nuance PDF
Converter Help].

Manuals
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Trademarks

Microsoft, Windows, Windows Vista, Excel, PowerPoint, Outlook, SharePoint, Windows Live,
Internet Explorer, and OneDrive are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

Word is the product of Microsoft Corporation in the United States.

Apple, App Store, the Apple logo, Mac, Mac OS, OS X, macOS, iPad, iPhoto, iPod touch, and
iTunes are trademarks of Apple Inc.

Nuance, the Nuance logo and Dragon are trademarks and/or registered trademarks of Nuance
Communications, Inc. and/or its affiliates in the United States and/or other countries.

Intel and Intel Core are registered trademarks or trademarks of Intel Corporation in the United States
and other countries.

ABBYY™ FineReader™ Engine © ABBYY. OCR by ABBYY

ABBYY and FineReader are trademarks of ABBYY Software, Ltd. which may be registered in some
jurisdictions.

Evernote is a registered trademark or trademark of Evernote Corporation.

Google, Android, Google Play, and Google Drive are registered trademarks or trademarks of Google
Inc. Use of these registered trademarks or trademarks is subject to Google Permissions.

Salesforce, the Salesforce logo, and Salesforce CRM are registered trademarks or trademarks of
salesforce.com, inc. in the United States and other countries.

Wi-Fi, Wi-Fi Protected Setup, and the Wi-Fi Protected Setup logo are trademarks of Wi-Fi Alliance.

ScanSnap, the ScanSnap logo, ScanSnap Manager, ScanSnap Organizer, CardMinder, and Rack2-
Filer are registered trademarks or trademarks of PFU Limited in Japan.

Other company names and product names are the registered trademarks or trademarks of the
respective companies.

Trademarks
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Manufacturer

PFU Limited

YOKOHAMA i-MARK PLACE, 4-4-5 Minatomirai, Nishi-ku, Yokohama, Kanagawa, 220-8567, Japan

© PFU Limited 2013-2017

Manufacturer
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Symbols Used in This Manual

The following indications are used in this manual to obviate any chance of accident or damage to
you and people near you, and your property. Warning labels indicate the warning level and
statements. The symbols indicating warning levels and their meanings are as follows.

Indication Description

�������

This indication alerts operators of an operation that, if not strictly observed, may result
in safety hazards to personnel or damage to the product.

Symbols Used in This Manual
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Arrow Symbols in This Manual

Right-arrow symbols (→) are used to connect icons or menu options you should select in
succession.

Example: From the sidebar in Finder, select [Applications] → [ScanSnap].

Arrow Symbols in This Manual
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Screen Examples in This Manual

The screenshots used in this manual are of OS X El Capitan v10.11.

The actual windows and operations may differ depending on the operating system.

The screen examples in this manual are subject to change without notice in the interest of product
development.

If the actual window differs from the screen examples in this manual, operate by following the actual
displayed screen.

Screen Examples in This Manual
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Abbreviations Used in This Manual

When a ScanSnap model is referred to in this manual, "Color Image Scanner ScanSnap" is omitted.

Also, the following abbreviations are used in this manual.

Abbreviation Used Designation

Mac OS macOS High Sierra v10.13
macOS Sierra v10.12
OS X El Capitan v10.11

Word Microsoft® Word 2016 for Mac
Microsoft® Word for Mac 2011

Excel Microsoft® Excel® 2016 for Mac
Microsoft® Excel® for Mac 2011

PowerPoint Microsoft® PowerPoint® 2016 for Mac
Microsoft® PowerPoint® for Mac 2011

Nuance Nuance®

ABBYY FineReader for
ScanSnap

ABBYY FineReader for ScanSnap™
All the descriptions in this manual assume the usage of ABBYY FineReader for
ScanSnap bundled with the ScanSnap. Unless otherwise specified, the term ABBYY
FineReader for ScanSnap refers to the ABBYY FineReader for ScanSnap bundled
with the ScanSnap.
Note that ABBYY FineReader for ScanSnap may be upgraded without notice. If the
descriptions in this manual differ from the actual displayed screens, refer to the
ABBYY FineReader for ScanSnap User's Guide.

Google Drive Google Drive™
Android Android™
ScanSnap Color Image Scanner ScanSnap series (*1)

Carrier Sheet ScanSnap Carrier Sheet

*1: The ScanSnap N1800 series is not included.

Abbreviations Used in This Manual
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What You Can Do with the ScanSnap

The ScanSnap model that performs overhead scanning has a scanning unit that does not touch
documents. The following scanning operations can be performed with this model:

l A book or booklet that is up to A3 in size can be scanned without cutting pages out.

l Multiple documents such as business cards or other types of cards can be scanned at once.

The scanned images created by scanning documents are corrected automatically.

l When a booklet-like document is scanned

The page distortion is corrected automatically.

l When multiple documents are scanned at once

The scanned images are cropped into separate images for respective documents.

In addition, continuous scanning can be started automatically and scanned images can be corrected
after documents are scanned.

Page Turning Detection
When a page is turned, the ScanSnap automatically starts continuous scanning.

This is useful for scanning multiple pages of a book or booklet-like document.

For details, refer to "Scanning Documents Using Page Turning Detection" (page 80).

Timed Mode
The ScanSnap automatically starts scanning after the specified time period passes.

What You Can Do with the ScanSnap
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This is useful also for scanning multiple documents (of any type) consecutively.

There are two types of settings for timed mode:

l Setting the time period before the ScanSnap starts scanning a document after the [Scan] button
is pressed

l Setting the time period for the ScanSnap to start the next scan when a document is scanned
continuously

For details, refer to "Scanning Documents Using Timed Mode" (page 84).

Correcting Scanned Images
After the documents are scanned with the ScanSnap, the scanned images can be corrected.

The following functions are available:

When a document is scanned
l "Filling in Fingers Captured in a Scanned Image (When a Document Is Scanned)" (page 90)

When a book is scanned
l "Correcting Distorted Book Images" (page 95)

l "Splitting a Double-Page Spread Image into Two Page Images" (page 100)

What You Can Do with the ScanSnap
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l "Filling in Fingers Captured in a Scanned Image (When a Book Is Scanned)" (page 103)

When multiple documents are scanned at once
l "Correcting the Scanned Image Orientation" (page 108)

l "Modifying the Crop Area" (page 111)

l "Adding the Necessary Scanned Images" (page 113)

l "Deleting Unnecessary Scanned Images" (page 115)

Scanning Documents with Two ScanSnaps Connected to a Computer
You can use SV600 and another ScanSnap connected to a computer.

For details, refer to "Scanning Documents with Two ScanSnaps Connected to a Computer" (page
87).

What You Can Do with the ScanSnap
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Scanning a Document

1. Press the [Scan] or [Stop] button on the ScanSnap to turn the power on.

[Scan] Button

[Stop] Button

a The power LED lights up in blue.

In addition, the ScanSnap Manager icon in the Dock changes from  to .

2. Place the Background Pad on the front side of the ScanSnap.
Place the Background Pad so that it is in contact with the ScanSnap.

3. Place a document in the scan area of the ScanSnap and press the [Scan]
button.
For details, refer to "How to Place Documents" (page 54).

Scanning a Document
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White Sheets

a Scanning starts.

ATTENTION
l Do not perform the following operations during scanning. Doing so will stop scanning.

- Connect or disconnect the ScanSnap and other USB devices.
- Switch users.
- Allow the computer to enter sleep mode.

l Do not cover the white sheet with an object or hand during scanning. The color reproduction
of the scanned image will be affected.

l Do not shake the table or desk when the ScanSnap is being used or move the documents
while they are being scanned. Doing so may distort the scanned image or blur the color.

HINT

You can also start scanning a document by clicking the ScanSnap Manager icon  in the
Dock while holding down the [control] key on the keyboard and then selecting [Scan] from the
"ScanSnap Manager Menu" (page 42).

a The power LED on the ScanSnap flashes in blue while the documents are being scanned.

The [ScanSnap Manager - Image scanning and file saving] window appears.

Scanning a Document
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a When scanning is complete, the [ScanSnap Manager - Image scanning and file saving]
window displays a scanning standby status.

HINT
To continue scanning, place down the next document to be scanned, and then perform one of
the following operations. Continuous scanning starts.
l Clicking the [Continue Scanning] button in the [ScanSnap Manager - Image scanning and file

saving] window
l Pressing the [Scan] button on the ScanSnap

4. To finish scanning, click the [Finish Scanning] button or press the [Stop]
button on the ScanSnap.
a A window is displayed for selecting how to save the scanned images.

In the preview area, the scanned images are cropped and displayed.

Scanning a Document
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5. Select [Flat document], and then click the [Save this image] button.

HINT
Click the [Check/Correct] button in the [ScanSnap Manager - Image scanning and file saving]
window to correct the scanned image. The following functions are available:
l "Filling in Fingers Captured in a Scanned Image (When a Document Is Scanned)" (page

90)
l "Correcting the Scanned Image Orientation" (page 108)
l "Modifying the Crop Area" (page 111)

a The Quick Menu appears.

6. In the Quick Menu, click the icon of the application to link with ScanSnap
Manager.

When you select , you can manage scanned images by folder with ScanSnap
Organizer.

For details, refer to "Managing Paper Documents by Folder on a Computer" (page 74).

Scanning a Document
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a The selected application starts up. For details, refer to the Advanced Operation Guide.

ATTENTION
l You cannot start scanning when the Quick Menu is displayed. Either select an icon from the

Quick Menu and finish the process, or close the Quick Menu before you perform the next
scan.

l Do not move, delete, or rename scanned images using other applications while the Quick
Menu is displayed.

HINT

l Clicking  displays the description of an application. Placing the mouse cursor over the
icon of another application displays the description of the application.

l Performing a scan while an application that can be automatically linked with is active
automatically starts the linkage between ScanSnap Manager and the application.
For details, refer to the Advanced Operation Guide.

Scanning a Document
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Scanning a Book

1. Press the [Scan] or [Stop] button on the ScanSnap to turn the power on.

[Scan] Button

[Stop] Button

a The power LED lights up in blue.

In addition, the ScanSnap Manager icon in the Dock changes from  to .

2. Place the Background Pad on the front side of the ScanSnap.
Place the Background Pad so that it is in contact with the ScanSnap.

3. Place a book in the scan area of the ScanSnap and press the [Scan] button.
For details, refer to "How to Place Documents" (page 54).

HINT
You can also enable page turning detection by holding down the [Scan] button on the ScanSnap
for 2 seconds or longer. When page turning detection is used, turning a book's page
automatically starts scanning.
For details, refer to "Scanning Documents Using Page Turning Detection" (page 80).

Scanning a Book
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White Sheets

a Scanning of the book starts.

ATTENTION
l Do not perform the following operations during scanning. Doing so will stop scanning.

- Connect or disconnect the ScanSnap and other USB devices.
- Switch users.
- Allow the computer to enter sleep mode.

l Do not cover the white sheet with an object or hand during scanning. The color reproducibility
of the scanned image will be affected.

l Do not shake the table or desk when the ScanSnap is being used or move the documents
while they are being scanned. Doing so may distort the scanned image or blur the color.

HINT

l You can also start scanning a book by clicking the ScanSnap Manager icon  in the Dock
while holding down the [control] key on the keyboard and then selecting [Scan] from the
"ScanSnap Manager Menu" (page 42).

l When timed mode is used, after the specified time the ScanSnap automatically starts
scanning. For details, refer to "Scanning Documents Using Timed Mode" (page 84).

a The power LED on the ScanSnap flashes in blue while the book is being scanned.

The [ScanSnap Manager - Image scanning and file saving] window appears.

Scanning a Book
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a When scanning the book is complete, the [ScanSnap Manager - Image scanning and file
saving] window displays a scanning standby status.

HINT
To continue scanning the book, open the next page to be scanned, and then perform one of
the following operations: Continuous scanning of the book starts.
l Clicking the [Continue Scanning] button in the [ScanSnap Manager - Image scanning and

file saving] window
l Press the [Scan] button on the ScanSnap.

4. To finish scanning the book, click the [Finish Scanning] button or press the
[Stop] button on the ScanSnap.
a A window is displayed for selecting how to save the scanned images.

In the preview area, the scanned images of the book are cropped and displayed.

Scanning a Book
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5. Select [Double-page spread (Book/Magazine)], and then click the [Save this
image] button.

HINT
Click the [Check/Correct] button in the [ScanSnap Manager - Image scanning and file saving]
window to correct the scanned image. The following functions are available:
l "Correcting Distorted Book Images" (page 95)
l "Splitting a Double-Page Spread Image into Two Page Images" (page 100)
l "Filling in Fingers Captured in a Scanned Image (When a Book Is Scanned)" (page 103)

a The Quick Menu appears.

6. In the Quick Menu, click the icon of the application to link with ScanSnap
Manager.

When you select , you can manage scanned images by folder with ScanSnap
Organizer.

For details, refer to "Managing Paper Documents by Folder on a Computer" (page 74).

Scanning a Book
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a The selected application starts up. For details, refer to the Advanced Operation Guide.

ATTENTION
l You cannot start scanning when the Quick Menu is displayed. Either select an icon from the

Quick Menu and finish the process, or close the Quick Menu before you perform the next
scan.

l Do not move, delete, or rename scanned images using other applications while the Quick
Menu is displayed.

HINT

l Clicking  displays the description of an application. Placing the mouse cursor over the
icon of another application displays the description of the application.

l Performing a scan while an application that can be automatically linked with is active
automatically starts the linkage between ScanSnap Manager and the application.
For details, refer to the Advanced Operation Guide.

Scanning a Book
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Scanning Multiple Documents at Once

1. Press the [Scan] or [Stop] button on the ScanSnap to turn the power on.

[Scan] Button

[Stop] Button

a The power LED lights up in blue.

In addition, the ScanSnap Manager icon in the Dock changes from  to .

2. Place the Background Pad on the front side of the ScanSnap.
Place the Background Pad so that it is in contact with the ScanSnap.

3. Place a document in the scan area of the ScanSnap and press the [Scan]
button.
For details, refer to "How to Place Documents" (page 54).

Scanning Multiple Documents at Once
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White Sheets

a Scanning starts.

ATTENTION
l Do not perform the following operations during scanning. Doing so will stop scanning.

- Connect or disconnect the ScanSnap and other USB devices.
- Switch users.
- Allow the computer to enter sleep mode.

l Do not cover the white sheet with an object or hand during scanning. The color reproducibility
of the scanned image will be affected.

l Do not shake the table or desk when the ScanSnap is being used or move the documents
while they are being scanned. Doing so may distort the scanned image or blur the color.

HINT

You can also start scanning a document by clicking the ScanSnap Manager icon  in the
Dock while holding down the [control] key on the keyboard and then selecting [Scan] from the
"ScanSnap Manager Menu" (page 42).

a The power LED on the ScanSnap flashes in blue while the documents are being scanned.

The [ScanSnap Manager - Image scanning and file saving] window appears.

Scanning Multiple Documents at Once
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a When scanning is complete, the [ScanSnap Manager - Image scanning and file saving]
window displays a scanning standby status.

HINT
To continue scanning, place down the next document to be scanned, and then perform one of
the following operations. Continuous scanning starts.
l Clicking the [Continue Scanning] button in the [ScanSnap Manager - Image scanning and file

saving] window
l Press the [Scan] button on the ScanSnap.

4. To finish scanning, click the [Finish Scanning] button or press the [Stop]
button on the ScanSnap.
a A window is displayed for selecting how to save the scanned images.

Scanning Multiple Documents at Once
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In the preview area, the scanned images are cropped and each scanned image is
displayed as a separate document.

5. Select [Flat document], and then click the [Save this image] button.

HINT
Click the [Check/Correct] button in the [ScanSnap Manager - Image scanning and file saving]
window to correct the scanned image. The following functions are available:
l "Correcting the Scanned Image Orientation" (page 108)
l "Modifying the Crop Area" (page 111)
l "Adding the Necessary Scanned Images" (page 113)
l "Deleting Unnecessary Scanned Images" (page 115)

a The Quick Menu appears.

6. In the Quick Menu, click the icon of the application to link with ScanSnap
Manager.

By selecting , you can save business card data in CardMinder.

For details, refer to "Saving Business Cards to a Computer" (page 77).

Scanning Multiple Documents at Once
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a The selected application starts up. For details, refer to the Advanced Operation Guide.

ATTENTION
l You cannot start scanning when the Quick Menu is displayed. Either select an icon from the

Quick Menu and finish the process, or close the Quick Menu before you perform the next
scan.

l Do not move, delete, or rename scanned images using other applications while the Quick
Menu is displayed.

HINT

l Clicking  displays the description of an application. Placing the mouse cursor over the
icon of another application displays the description of the application.

l Performing a scan while an application that can be automatically linked with is active
automatically starts the linkage between ScanSnap Manager and the application.
For details, refer to the Advanced Operation Guide.

Scanning Multiple Documents at Once
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ScanSnap Overview

This section provides an overview that you should be aware of before operating ScanSnap.

l "Parts and Functions" (page 34)

l "System Requirements" (page 37)

l "Overview of the Software Related to the ScanSnap" (page 39)

l "How to Install the Software" (page 40)

l "ScanSnap Manager Icon" (page 41)

l "ScanSnap Manager Menu" (page 42)

l "ScanSnap Setup Window" (page 45)

l "Turning the ScanSnap On or Off" (page 47)

l "Documents to Scan" (page 53)

l "How to Place Documents" (page 54)

ScanSnap Overview
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Parts and Functions

This section explains the names and functions of the ScanSnap parts.

Front

2

1

3

4

5

6
7

8

No. Name Description

1 Head -

2 Neck -

3 [Scan] button (*1) l Turns on the ScanSnap.
l Starts scanning.

4 [Stop] button (*1) l Turns the ScanSnap on or off.
l Stops scanning.

5 Base -

6 Power LED Indicates the status of the ScanSnap as follows:
Blue (lit): Ready
Blue (flashing): Scanning
Orange (flashing): Error

7 White sheet Used to determine the starting position for scanning documents and
is also the standard color reference for the color of documents when
documents are scanned.

8 Centering mark When placing a book or standard size document, align the center of
the document with the centering mark.

*1: If the ScanSnap has turned off automatically because of the automatic power off function, press
the [Scan] or [Stop] button to turn the ScanSnap back on. (Pressing the [Scan] button does not
start scanning.)

For details, refer to "Automatic Power OFF" (page 52).

Parts and Functions
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ATTENTION
When carrying the ScanSnap, hold its base and neck. Do not carry the scanner by the head.

Back

9

10
11

No. Name Description

9 Security cable slot Used to connect an anti-theft security cable (commercially available).

10 USB connector Used to connect a USB cable.

11 Power connector Used to connect the AC cable.

Scanning Unit
Operates when documents are scanned.

Parts and Functions
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12
13
14

15

No. Name Description

12 Camera Detects page turning and glossy papers.

13 Infrared LED Irradiates the scan area with infrared to detect page turning and
glossy papers.

14 Glass Protects the lens used to scan a document.

15 Lamp Illuminates the document to be scanned.

Parts and Functions
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System Requirements

The ScanSnap has the following system requirements.

For the latest information on requirements, please visit the ScanSnap Support Site at:

http://scansnap.fujitsu.com/g-support/en/

Operating system (*1) (*2) macOS High Sierra v10.13 (*3)
macOS Sierra v10.12.1 or later (*3)
OS X El Capitan v10.11

CPU Intel® Core™ i5 2.5 GHz or higher

Memory 4 GB or more

Display resolution 1024 × 768 pixels or higher

Disk space Free space required to install the software related to the ScanSnap is as follows:
(*4)
l ScanSnap Manager: 640 MB
l ScanSnap Organizer: 95 MB
l CardMinder: 600 MB
l ABBYY FineReader for ScanSnap: 980 MB
l ScanSnap Online Update: 20 MB
l OCR Pack (*5)
l ScanSnap SV600 Basic Operation Guide: 100 MB
l Nuance PDF Converter for Mac: 140 MB

USB port USB 3.0(*6)/USB 2.0/USB 1.1

*1: Updating Mac OS to the latest version is recommended.

*2: For the system requirements of the PDF editing software, refer to the following:

How to Install PDF Editing Software

http://www.pfu.fujitsu.com/imaging/downloads/manual/install/en

*3: ABBYY FineReader for ScanSnap 5.0 is not supported.

*4: To save scanned images, more free space is required.

For details about estimated image data size, refer to the ScanSnap Manager Help.

*5: By installing the OCR Pack, you can add extra languages to recognize text.

For the amount of free space required to install the OCR Pack, refer to the following:

http://www.fujitsu.com/global/support/products/computing/peripheral/scanners/scansnap/
software/ocrpack-setup.html

*6: Even if you connect the ScanSnap to a USB 3.0 compatible port, the scanner operates as a USB
2.0 device.

ATTENTION
l If the system requirements above are not satisfied, the ScanSnap may not operate.
l If a USB port on the keyboard or on the monitor is in use, the ScanSnap may not operate.
l When using a commercially available USB hub, use a type that is powered from an electrical power

supply (and that comes with an adapter).
l Scanning speed decreases in the following cases:

- The CPU or the memory does not meet the recommended specifications.
- The version of the USB port or the USB hub is USB 1.1.

System Requirements
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l To scan a document, a disk space that is approximately three times larger than the size of the file
to be saved is required.

System Requirements
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Overview of the Software Related to the ScanSnap

This section gives an overview of each bundled software and their functions. You can edit, manage,
and arrange the scanned image by using the following software:

ScanSnap Manager
This scanner driver is required to scan documents with the ScanSnap. Scanned images can be
saved as PDF or JPEG files to a computer.

You need to have ScanSnap Connect Application installed on your mobile device to save PDF or
JPEG files to your mobile device.

You can download ScanSnap Connect Application for your mobile device from its application
market.

ScanSnap Organizer
You can use this application to display image data (PDF or JPEG files) in a list, create folders, and
arrange files as you like.

CardMinder
You can use this application to efficiently digitalize a large number of business cards.

Text recognition can be performed on business cards and you can create a database to facilitate
card data management and searches. Data in the database can be printed and linked with various
applications. The data can be also shared with PIM (Personal Information Manager), such as
Contacts.

ABBYY FineReader for ScanSnap
This application can perform text recognition on the scanned images using OCR (Optical
Character Recognition) to convert the image data to Word, Excel, or PowerPoint files that can be
edited.

ScanSnap Online Update
This application checks whether the latest updates or software programs are available on the
download server. When the latest updates or software programs are available, you can
automatically apply updates or download and install the software programs manually.

Evernote for Mac
You can easily save files in Evernote using the ScanSnap.

Dropbox for Mac
You can easily save files to your Dropbox folder using the ScanSnap.

Nuance PDF Converter for Mac
This is a application for creating, editing, managing, and utilizing PDF format electronic
documents.

Overview of the Software Related to the ScanSnap
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How to Install the Software

When you insert the Setup DVD-ROM into the DVD-ROM drive on your computer, the [ScanSnap]
window appears.

ATTENTION
l Do not connect the ScanSnap to the computer before installing the software. Doing so may cause

the ScanSnap not to be recognized by the computer. In that case, install the software, and then
reconnect the ScanSnap to the computer.

l If a DVD-ROM drive is not available, the installers for the software programs can be downloaded
from the following web page.
http://scansnap.fujitsu.com/g-support/en/

The functions of each button in the [ScanSnap] window are as follows.

Icon Function

ScanSnap Starts installing software.

Other Software Displays the [Other Software] window. From this window, you can access the
download web pages of the software programs.

Readme Displays the Readme file.

Manuals The [Manuals] window appears. You can refer to Safety Precautions, Getting Started,
the Basic Operation Guide (this manual), and the Advanced Operation Guide.

How to Install the Software
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ScanSnap Manager Icon

When ScanSnap Manager is running, the ScanSnap Manager icon is displayed in the Dock.

The ScanSnap Manager icon indicates whether or not ScanSnap Manager is successfully
communicating with the ScanSnap. The appearance of the icon changes according to the
communication status as shown below.

Communication Status ScanSnap Manager Icon

Communicating

Not communicating

HINT
Turn the ScanSnap on to begin communication between ScanSnap Manager and the ScanSnap. For
details about how to turn on the ScanSnap, refer to "Turning the ScanSnap On" (page 48).

You can display the menu for scanning documents and ScanSnap Manager settings from the
ScanSnap Manager icon.

l Clicking while holding down the [control] key on the keyboard

Displays the "ScanSnap Manager Menu" (page 42).

l Clicking

Displays the Profile menu.

For details, refer to the Advanced Operation Guide.

ScanSnap Manager Icon
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ScanSnap Manager Menu

This menu appears when you click the ScanSnap Manager icon  in the Dock while holding
down the [control] key on the keyboard.

Click While Pressing the [control] 
Key on the Keyboard

Item Function

Scan Scans the document placed in the scan area of the ScanSnap. Follows the settings
configured in [Settings].

Settings Displays the "ScanSnap Setup Window" (page 45). You can configure the scan
settings in this window.

Profile Displays the Profile menu.
You cannot select this when the [Use Quick Menu] checkbox is selected in the
ScanSnap setup window.

Profile Management Displays the [ScanSnap Manager - Profile Management] window.
You cannot select [Profile Management] when the [Use Quick Menu] checkbox is
selected in the ScanSnap setup window.
For details, refer to the Advanced Operation Guide.

Connect by Wi-Fi Displays the [ScanSnap Manager - Connect by Wi-Fi] window.
Available with iX500 and iX100.

Preferences Displays the [ScanSnap Manager - Preferences] window.

ScanSnap Manager Menu
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Item Function

Help Displays the following menu:
l Help

Opens the ScanSnap Manager Help.
l Troubleshooting

Displays [Troubleshooting] in the ScanSnap Manager Help.
l ScanSnap Portal Site

Opens the ScanSnap global homepage (http://scansnap.fujitsu.com).
l About ScanSnap Manager

Displays the [ScanSnap Manager - Version Information] window.
l ScanSnap information

Displays the [ScanSnap Manager - Scanner and driver information] window.
Displayed when the ScanSnap and computer are connected.

l Online Update
Starts the ScanSnap Online Update.
For details, refer to "Updating the Software" (page 130).

To establish connection Displayed when ScanSnap Manager is not communicating with the ScanSnap
correctly.

Options Displays the following menu:
l Keep in Dock

Adds the ScanSnap Manager icon  to the Dock.
l Open at Login

Automatically launches ScanSnap Manager when the computer is started up or
logged in.

l Show in Finder
Displays the contents of the [ScanSnap] folder by using the Finder.

Show All Windows Shows all windows from ScanSnap Manager in thumbnails.

Hide/Show Hides or shows all windows from ScanSnap Manager.

Quit Quits ScanSnap Manager.

HINT
When SV600 and one of iX500, iX100, S1500, S1500M, S1300i, S1300, S1100i, and S1100 are
connected to a computer, the Right-Click Menu displays items relevant to each of the connected
ScanSnap models.
For details, refer to the ScanSnap Manager Help.

ScanSnap Manager Menu
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When SV600 and iX500 are connected to a computer
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ScanSnap Setup Window

When you click the ScanSnap Manager icon  while holding down the [control] key on the
keyboard, and then select [Settings] from the "ScanSnap Manager Menu" (page 42), the following
ScanSnap setup window appears.

In the ScanSnap setup window, you can use the [Use Quick Menu] checkbox to specify whether or
not to use the Quick Menu. You can also use the profile buttons and detail setting tabs to specify
scan settings according to your scanning needs.

For details, refer to the ScanSnap Manager Help.

Profile Buttons

Detail Setting Tabs

HINT
When SV600 and one of iX500, iX100, S1500, S1500M, S1300i, S1300, S1100i, and S1100 are
connected to a computer, you can change the scan settings for each of the connected ScanSnap
models by selecting the model name from [Scanner] on the ScanSnap setup window.

ScanSnap Setup Window
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Turning the ScanSnap On or Off

This section explains how to turn the ScanSnap on or off.

l "Turning the ScanSnap On" (page 48)

l "Turning the ScanSnap Off" (page 50)

l "Sleep Mode" (page 51)

l "Automatic Power OFF" (page 52)

Turning the ScanSnap On or Off
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Turning the ScanSnap On

1. Turn on the computer.

a The computer starts up and the ScanSnap Manager icon  appears in the Dock.

HINT

l If the ScanSnap Manager icon  is not displayed in the Dock, click [Applications] from the
sidebar in Finder, click [ScanSnap], and then double-click [ScanSnap Manager].

l If ScanSnap Manager does not automatically start when you log in to the computer, display
the [System Preferences] window and select [Users & Groups] → [Current User] → [Login

Items] → [ ] → [ScanSnap] → [ScanSnap Manager].

2. Press the [Scan] or [Stop] button on the ScanSnap to turn the power on.

[Scan] Button

[Stop] Button

ATTENTION
When turning the power on, do not cover the white sheet with a hand.

a The [Scan] button lights up in blue.

In addition, the ScanSnap Manager icon in the Dock changes from  to .

HINT

l It may take more time for the ScanSnap Manager icon in the Dock to change to 
depending on computer performance, operating environment, or loading, for example, when
many software programs are running at the same time.

l When the ScanSnap is turned on, a notification window notifies you of the ScanSnap's
communication status.

Turning the ScanSnap On or Off
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To disable notifications of the ScanSnap's communication status, change the setting in the
following procedure:

1. Click the ScanSnap Manager icon  in the Dock while holding down the [control] key
on the keyboard, and then select [Preferences] from the "ScanSnap Manager Menu"
(page 42).
a The [ScanSnap Manager - Preferences] window appears.

2. Clear the [Notify of the communication status] checkbox in the [Status Display] list.

Turning the ScanSnap On or Off
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Turning the ScanSnap Off

1. Press the [Stop] button on the ScanSnap for three seconds or longer.

a The power LED turns off.

In addition, the ScanSnap Manager icon in the Dock changes from  to .

ATTENTION
If moving the ScanSnap, first turn the power off and remove all cables.

HINT
l When the computer is turned off, the ScanSnap is also turned off.
l When the ScanSnap is turned off, a notification window notifies you of the ScanSnap's

communication status.
To disable notifications of the ScanSnap's communication status, change the setting in the
following procedure:

1. Click the ScanSnap Manager icon  in the Dock while holding down the [control] key
on the keyboard, and then select [Preferences] from the "ScanSnap Manager Menu"
(page 42).
a The [ScanSnap Manager - Preferences] window appears.

2. Clear the [Notify of the communication status] checkbox in the [Status Display] list.

Turning the ScanSnap On or Off
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Sleep Mode

When the ScanSnap is on and has not been used for 15 minutes, it enters sleep (power saving)
mode.

Turning the ScanSnap On or Off
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Automatic Power OFF

When the ScanSnap is turned on and left unused for the specified time (default is "4 hours"), it will
turn itself off automatically.

To turn the ScanSnap back on, perform one of the following operations:

l Press the [Scan] button on the ScanSnap (this will not start scanning)

l Press the [Stop] button on the ScanSnap

HINT
l To continue using the ScanSnap, reset the time until auto power-off by pressing the [Scan] button

on the ScanSnap.
l You can change the time of the ScanSnap to turn off automatically or change the setting so that it

will not turn off automatically. Set according to the following procedures:

1. Click the ScanSnap Manager icon  in the Dock while holding down the [control] key on the
keyboard, and then select [Preferences] from the "ScanSnap Manager Menu" (page 42).
a The [ScanSnap Manager - Preferences] window appears.

2. In the [Power] list, change the settings for [Power setting] based on how it is connected.
l A notification window notifies you 5 minutes before the ScanSnap turns off automatically.

Turning the ScanSnap On or Off
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Documents to Scan

The following documents can be scanned because the scanning unit does not touch the documents.

l Thick documents, such as books

l Documents that you want to keep intact, such as photographs and handwritten illustrations

Conditions for Documents to Scan
Document type Flat documents, such as office paper,

postcards, and business cards
Thick documents, such as books

Document
thickness

5 mm (0.2 in.) or less 5 to 30 mm (0.2 to 1.18 in.)

Paper size Width: 25.4 to 432 mm (1 to 17 in.)
Length: 25.4 to 300 mm (1 to 11.8 in.)

Width: 25.4 to 400 mm (1 to 15.7 in.)
Length: 25.4 to 300 mm (1 to 11.8 in.)

ATTENTION
l When you scan a glossy document, the scanned image may be affected as follows:

- Part of the scanned image appears brighter or darker than the original
- Glare from the lamp is caught in the scanned image

l If a document has wrinkles, curls, or folds, smooth it out before scanning. Otherwise, the scanned
image may be affected as follows:
- The scanned image is distorted
- The scanned image is blurred
- Part of the document does not appear in the scanned image

l When you scan irregular shaped documents that are not rectangular or square, the scanned
images are not corrected automatically.

HINT
You can show a confirmation message in the case of scanning documents that reflect lamp light
causing glare, such as glossy paper.
For details, refer to the ScanSnap Manager Help.
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How to Place Documents

When you place down documents, use the Background Pad.

If you scan documents without using the Background Pad, the document edges may not be detected
correctly and the created scanned image may be different from the document.

For details about documents that can be scanned with the ScanSnap, refer to "Documents to Scan"
(page 53).

l "Scan Area" (page 54)

l "When Placing a Standard Size Document" (page 55)

l "When Placing a Book" (page 55)

l "When Placing Multiple Documents at Once" (page 55)

Scan Area
Place a document with the scanned side face-up in the following scan area.

Use the following to determine the scan area.

l Area: Reference marks of the Background Pad

l Height: Lines on the base of the ScanSnap

30 mm (1.18 in.)

Line

5 mm (0.2 in.)

300 mm (11.81 in.)

400 mm 

432 mm
(15.75 in.) 

(17.01 in.)

ATTENTION
If a document is placed outside of the scan area, part of the scanned image may be left out or blurred.

How to Place Documents
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When Placing a Standard Size Document
When you select an option other than [Automatic detection] for [Paper size] on the [Paper] tab in the
"ScanSnap Setup Window" (page 45), align the center of the document with the centering mark on
the ScanSnap.

SV600

When Placing a Book
Place a book as follows:

l Open a book horizontally.

l Align the center of the opened book face-up with the centering mark.

l Hold the book down with fingers within the appropriate areas.

When holding the book down, use your fingers as follows:

- Keep your fingers straight.

- When using multiple fingers to hold down the book, keep fingers apart by at least 2 cm (0.79
in.).

SV600

20 mm (0.79 in.)

50 mm (1.97 in.)

20 mm (0.79 in.)

Appropriate Areas for Holding the Book Down

When Placing Multiple Documents at Once
To scan multiple documents at once, place them in the following conditions:

l The documents must be placed at least 15 mm (0.59 in.) apart from each other.

How to Place Documents
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l The number of documents placed must not exceed 10.

SV600

15 mm (0.59 in.) or More

15 mm (0.59 in.) or More

How to Place Documents
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What You Can Do with Related Software

This section explains the basic operation procedure of software related to the ScanSnap and gives
an overview of its functions.

l "What You Can Do with the ScanSnap Organizer" (page 58)

l "What You Can Do with CardMinder" (page 64)

What You Can Do with Related Software
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What You Can Do with the ScanSnap Organizer

ScanSnap Organizer is an application used for displaying, organizing, and managing image data
(PDF or JPEG files) scanned with the ScanSnap.

You can use this application to create folders and arrange files for various uses.

Pages of a PDF file can be opened with an associated application to check the scanned image data.

Main Window

Scan documents with the ScanSnap

l "Basic Operation Procedure of ScanSnap Organizer" (page 59)

l "Managing Files" (page 60)

l "Editing Files" (page 62)

l "Using Files" (page 63)

What You Can Do with the ScanSnap Organizer
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Basic Operation Procedure of ScanSnap Organizer

This section explains the basic operation procedure of ScanSnap Organizer.

1. From the sidebar in Finder, select [Applications] → [ScanSnap Organizer],
and then double-click [ScanSnap Organizer] to start up ScanSnap Organizer.

2. Scan documents with the ScanSnap.
a A list of scanned images is displayed in ScanSnap Organizer.

What You Can Do with the ScanSnap Organizer
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Managing Files

For details about operations, refer to the ScanSnap Organizer Help.

Setting a Marked Character String as a Keyword
Keywords can be set to a PDF file by using the keyword setting function.

These keywords can be used when you search for PDF files.

When black and white documents that have been marked are scanned by the ScanSnap, the
marked character strings are set as keywords for the PDF file.

Mark the characters 
on a document

"Proposal" can be used as a keyword 
to search for the file

Document PDF file with a keyword

Proposal

Proposal

Scan the document 
with the ScanSnap

Recognizing a Character String in a Page to Embed It into the Page
By using text recognition (OCR) software, you can embed character strings into the page of a PDF
file scanned by the ScanSnap, and then search the PDF file using the character strings.

OCR recognizes "proposal" 
as textual information.

PDF file

"Proposal" can be used 
as a keyword 
to search for the fileProposal

What You Can Do with the ScanSnap Organizer
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Searching Files
You can search files that are managed in ScanSnap Organizer.

What You Can Do with the ScanSnap Organizer
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Editing Files

For details about operations, refer to the ScanSnap Organizer Help.

Correcting a book distortion
By starting Book Image Viewer from ScanSnap Organizer, you can correct distorted images of
scanned books.

For details about other image correction functions, refer to the ScanSnap Organizer Help.

What You Can Do with the ScanSnap Organizer
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Using Files

For details about operations, refer to the ScanSnap Organizer Help.

Linking Files with Other Applications
You can use files with a variety of applications.

Sending Files by E-mail
Files can be sent by e-mail.

Using Files by Syncing with a Mobile Device
By using the ScanSnap Sync function, an image file scanned by the ScanSnap can be synced
automatically with a mobile device and can be used easily anytime or anywhere via a cloud service.

The files are organized and managed in the "ScanSnap Sync" folder in ScanSnap Organizer.

Syncing Files Made up of Images That Were Saved Together ("JPEG
(Save together)" Files)
Using the ScanSnap Sync function allows you to sync "JPEG (Save together)" files between a
mobile device and ScanSnap Organizer.

A "JPEG (Save together)" file consists of multiple images that are scanned with ScanSnap Connect
Application.

What You Can Do with the ScanSnap Organizer
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What You Can Do with CardMinder

CardMinder is an application used for displaying, organizing, and managing card image data
scanned with the ScanSnap.

This application digitalizes large amounts of business cards into images at a high speed and
recognizes text on those cards, thus allowing you to search for your clients' business cards from
those data quickly, and create your client databases conveniently. CardMinder uses an Optical
Character Recognition (OCR) engine to recognize text on cards and shares the data with Personal
Information Manager (PIM) applications.

CardMinder also enables business card data to be quickly searched from other applications.

Card

CardMinder window

Scan using ScanSnap

Recognized data

Share the recognized data with PIM
(Example: Contacts)

l "Basic Operation Procedure of CardMinder" (page 66)

l "Linking Card Data with Other Applications" (page 69)

l "Searching Card Data with the Basic Search Toolbar" (page 70)

l "Searching Card Data with Keyboard Shortcuts" (page 71)

What You Can Do with CardMinder
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l "Attaching a File to Card Data" (page 72)

What You Can Do with CardMinder
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Basic Operation Procedure of CardMinder

This section explains the basic operation procedure of CardMinder.

1. Start CardMinder.
From the sidebar in Finder, select [Applications] → [CardMinder], and then double-click
[CardMinder].

2. Scan a card with the ScanSnap.
Load a card in the ScanSnap and press the [Scan] button to start scanning the card.

When scanning is complete, the information printed on the card (such as name, company, and
address) is automatically recognized as text and displayed in the Card Data Edit view.

The image data scanned from the card is displayed in the Card Image view.

ATTENTION
ScanSnap Manager must be installed on your computer when you want to recognize the
following languages:
l Chinese (simplified)
l Chinese (traditional)
l Korean

3. Check the card data.
Make sure that the front and back card images are correct, and that the text on the card
images are displayed correctly in the Card Data Edit view.

What You Can Do with CardMinder
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Card Data Edit ViewCard Image View

4. If the language to be used for text recognition is different, perform text
recognition again in the following procedure:
1. Select [CardMinder] menu → [Preferences].

a The [General] window appears.

2. Select a language for the character strings to be recognized from [Recognition Language].

a The recognition language changes.

3. Close the [General] window.

4. Click the [Recognize] button on the Toolbar again.

a Character strings on the card data will be recognized as the selected language.

What You Can Do with CardMinder
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5. Correct the card data, if necessary.
The card data can be corrected in the following ways. For details, refer to the CardMinder
Help.

l Redoing the recognition process on the character strings in the selected areas

l Entering text directly in the Card Data Edit view

l Correcting the orientation of the card image or switching the front and back images

3 41 2

No. Description

1 Using the [Rotate] button, you can rotate the card image.

2 Using the [Modify Image] button, you can switch the front and back images of the card image, create
double-sided cards, and delete the back image.

3 By selecting character strings in the card image and then clicking the buttons of the appropriate fields in
the Card Data Edit view, you can redo the recognition process on the selected areas.

4 You can directly correct the text of each field in the Card Data Edit view.

6. Exit CardMinder.
Click [CardMinder] menu → [Quit CardMinder] to quit CardMinder.

What You Can Do with CardMinder
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Linking Card Data with Other Applications

Click the following buttons on the Toolbar to use card data in a variety of applications.

The following explains an example in which the Toolbar is customized to display the [Application]
button.

1 2 3 4

No. Item Description

1 E-mail You can start an e-mail program, using the e-mail address specified in [E-mail] for
the card data as the destination address.

2 Internet search You can search the URL specified in [Website] for the card data with a web browser.

3 Outputting card data in
a different format

You can output card data in the vCard, CSV, text, or ContactXML format.

4 Linking card data with
another application

You can link card data with another application such as Outlook or Salesforce CRM
to use the card data in the linked application. You can also link card data with USB
media to use the card data on a different computer.

For details, refer to CardMinder Help.
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Searching Card Data with the Basic Search Toolbar

This section explains how to search card data with the CardMinder Basic Search Toolbar.

Find (Basic Search Toolbar)

To search card data, type in a search term (such as an individual name or a company name) in the
Basic Search Toolbar.

The search results are displayed in the Card Data List view.

What You Can Do with CardMinder
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Searching Card Data with Keyboard Shortcuts

Even when CardMinder is not running, you can search card data by using a character string in
another application (such as TextEdit) as the keyword for searching.

1. Drag the mouse to select a character string you want to search for.

2. Press [command ] + [shift] + [&] keys on the keyboard at the same time.
a While the Card Data Edit view is hidden, CardMinder starts and search is executed.

Card data matching the search conditions is displayed in the Card Data List view.

HINT
l Depending on the keyboard type, you may not have to press the [shift] key.
l If the keyboard shortcuts do not work, check the [Search Selected Text in CardMinder] shortcut key

by selecting [System Preferences] → [Keyboard] → [Services] in the [Keyboard Shortcuts] tab, and
change the shortcut key to the one to be used.

What You Can Do with CardMinder
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Attaching a File to Card Data

A file can be attached to card data easily by dragging and dropping it.

What You Can Do with CardMinder
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Useful Usages

This section explains how to use related software for the scanned image that is created after a
document is scanned with the ScanSnap and how to scan a document with a setting other than the
default setting.

l "Managing Paper Documents by Folder on a Computer" (page 74)

l "Saving Business Cards to a Computer" (page 77)

l "Scanning Documents Using Page Turning Detection" (page 80)

l "Scanning Documents Using Timed Mode" (page 84)

l "Scanning Documents with Two ScanSnaps Connected to a Computer" (page 87)

Useful Usages

73



Managing Paper Documents by Folder on a Computer

This section explains how to digitize paper documents and manage the data by folder in ScanSnap
Organizer.

1. Scan a paper document with the ScanSnap.
For details about scanning a document, refer to "Scanning a Document" (page 18).

a The Quick Menu appears.

2. Click the [ScanSnap Organizer] icon  in the Quick Menu.
a The [ScanSnap Organizer] window appears.

Managing Paper Documents by Folder on a Computer
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3. From the menu bar, select [File] → [New Folder].
a A new folder is created in the folder list.

4. Rename the created folder.

HINT
To create multiple folders, repeat steps 3 to 4.

5. Select the scanned image from the file list, and drag and drop it to the folder.

Managing Paper Documents by Folder on a Computer
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a The scanned image is moved to the folder.

HINT
For details about other functions, refer to the ScanSnap Organizer Help.
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Saving Business Cards to a Computer

This section explains how to digitize business cards and save the card data in CardMinder.

ATTENTION
If you do not log in as a user with Administrator privileges, you may not be able to link the ScanSnap
with another application properly.

1. Scan business cards with the ScanSnap.
For details about scanning business cards, refer to "Scanning Multiple Documents at Once"
(page 28).

a The Quick Menu appears.

2. Click the [CardMinder] icon  in the Quick Menu.
a The [CardMinder] window appears.
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3. Check the card data.
Make sure that the text on the card images are displayed correctly in the Card Data Edit view.

If the card data must be corrected, click the text to be corrected and then directly edit it.

Card Data Edit ViewCard Image View
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HINT
When you scan double-sided business cards, you must scan one side of each card and edit the card
data in CardMinder.
For details, refer to the CardMinder Help.
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Scanning Documents Using Page Turning Detection

This section explains how to detect page turning to start scanning automatically.

ATTENTION
When the installation environment of the ScanSnap or the specification of the book to be scanned
encounters any of the following, use timed mode to scan a document.
l Installation environment of the ScanSnap

- The ScanSnap is installed under direct sunlight
- The ScanSnap is installed under lighting that emits a lot of infrared rays such as incandescent

lamps
- The ScanSnap is under uneven lighting caused by some environmental factors such as the use

of a spotlight
- An object other than the book to be scanned is placed on the Background Pad
- A device that emits infrared light such as a heater is placed near the ScanSnap
- Movement of shadow such as a person appears on the Background Pad

l Book specifications
Books that are smaller than A4 (210 × 297 mm)/Letter (8.5 × 11 in. (216 × 279.4 mm)) when
opened in a double-page spread

Example: Comic books or pocket edition books

HINT
When scanning a document, you can also enable page turning detection by holding down the [Scan]
button on the ScanSnap for 2 seconds or longer. When this is the case, after you finish scanning the
documents, page turning detection becomes disabled again.

1. Click the ScanSnap Manager icon  in the Dock while holding down the
[control] key on the keyboard, and select [Settings] from the "ScanSnap
Manager Menu" (page 42).
a The ScanSnap setup window appears.

2. In the "ScanSnap Setup Window" (page 45), select the [Scanning] tab, and
click the [Option] button.
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a The [Scanning mode option] window appears.

3. Select the [Configure settings for starting the next scan.] checkbox and then
[Page turning detection mode].

4. Click the [OK] button to close the [Scanning mode option] window.

5. Click the [Apply] button in the ScanSnap setup window.

6. Click the [ ] button in the upper left of the window to close the ScanSnap
setup window.
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7. Open the page of a book you want to scan and place the book in the scan
area of the ScanSnap.
For details, refer to "How to Place Documents" (page 54).

8. Press the [Scan] button on the ScanSnap to start scanning the book.
a The [ScanSnap Manager - Image scanning and file saving] window appears.

a Once the scanning of the book page is complete, [Turn the page.] appears on the
[ScanSnap Manager - Image scanning and file saving] window.

9. Open the next page to be scanned.
Turn the pages at a constant speed. The recommended page turning speed is approximately
one to two seconds per page.
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a The page turning is detected and continuous scanning starts.

ATTENTION
l While the [Turn the page.] message appears on the [ScanSnap Manager - Image scanning

and file saving] window, if you hold or move your hand over the Background Pad, such
motion may be incorrectly detected as page turning.

l If continuous scanning does not start after a page is turned, click the [Continue Scanning]
button in the [ScanSnap Manager - Image scanning and file saving] window or press the
[Scan] button on the ScanSnap.

HINT
l To make page turning easy to detect, turn each page as follows:

- Pinch the bottom part of the page and turn it.
- Keep the page straight when turning it.

l You can change the time before the ScanSnap starts to scan a document after page turning
is detected.
On the [Scanning mode option] window shown in step 3, select the [Specify the waiting time
to start scanning after pressing the [Scan] button] checkbox, and change [Waiting time].

l To continue scanning, repeat step 9.

10. To finish scanning, click the [Finish Scanning] button or press the [Stop]
button on the ScanSnap.
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Scanning Documents Using Timed Mode

This section explains how to automatically start scanning by setting the time period for the document
scanning to start.

1. Click the ScanSnap Manager icon  in the Dock while holding down the
[control] key on the keyboard, and select [Settings] from the "ScanSnap
Manager Menu" (page 42).
a The ScanSnap setup window appears.

2. In the "ScanSnap Setup Window" (page 45), select the [Scanning] tab, and
click the [Option] button.

a The [Scanning mode option] window appears.

3. Set the time period before the ScanSnap starts scanning a document.
l To set the time period before the ScanSnap starts scanning a document after the [Scan]

button is pressed:

Select the [Specify the waiting time to start scanning after pressing the [Scan] button]
checkbox, and then specify [Waiting time].
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l To set the time period for the ScanSnap to start the next scan when a document is
scanned continuously:

1. Select the [Configure settings for starting the next scan] checkbox, and then select
[Timed interval (Timed mode)].

2. Specify [Scan interval].

4. Click the [OK] button to close the [Scanning mode option] window.

5. Click the [Apply] button in the ScanSnap setup window.
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6. Click the [ ] button in the upper left of the window to close the ScanSnap
setup window.

7. Place a document with the scanned side face-up in the scan area of the
ScanSnap.
For details, refer to "How to Place Documents" (page 54).

8. Press the [Scan] button on the ScanSnap.
a Scanning starts after the time period specified in [Waiting time] passes.

9. Place the next document to be scanned with the scanned side face-up in the
scan area.
For details, refer to "How to Place Documents" (page 54).

a Scanning starts after the time period specified in [Scan interval] passes.

HINT
To continue scanning, repeat step 9.

10. To finish scanning, click the [Finish Scanning] button or press the [Stop]
button on the ScanSnap.
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Scanning Documents with Two ScanSnaps
Connected to a Computer

You can use SV600 and another ScanSnap connected to a computer. When both of the ScanSnap
models are connected and turned on, you can use one of them at a time.

Note that you cannot scan a document with two ScanSnap models simultaneously. Before switching
the ScanSnap to use, make sure that a series of operations (from scanning a document to linking
the ScanSnap with an application) has been completed.

The following ScanSnap models can be connected to a computer and used together with SV600:

l iX500

l iX100

l S1500

l S1500M

l S1300i

l S1300

l S1100i

l S1100
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Correcting the Scanned Images

The scanned images can be corrected before ScanSnap Manager is linked with an application. The
scanned images can be corrected in the following cases:

l "Scanning a Document" (page 89)

l "Scanning Books" (page 94)

l "Scanning Multiple Documents at Once" (page 107)
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Scanning a Document

When a document is scanned with the ScanSnap, the following correction can be made on the
scanned image:

l "Filling in Fingers Captured in a Scanned Image (When a Document Is Scanned)" (page 90)
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Filling in Fingers Captured in a Scanned Image (When a
Document Is Scanned)

Fingers that are captured when a document is scanned can be filled in.

ATTENTION
l Do not hold the corners of the document when you scan.

If you do so, the shape of the image may not be recognized correctly.
l To fill in fingers captured in the scanned image, the fingers need to be detected.

If a document is scanned in the following ways, captured fingers may not be detected correctly.
- When two or more fingers that are used to hold down a document to be scanned are touching

each other (Figure 1)
- When you hold down a document to be scanned with manicured fingers or fingers with artificial

nails (Figure 2)
- When you hold down a document to be scanned with your fingers bent (Figure 3)
- When fingers that are used to hold down a document to be scanned are captured 1 cm (0.39

in.) or more (Figure 4)
- When there is text or an image within 5 mm (0.2 in.) around the fingers that are used to hold

down a document to be scanned (Figure 5)
- When a document that has a background color other than white is scanned (Figure 6)
- When a document is scanned after [Gray] or [B&W] is selected from the [Color mode] drop-

down list in the [Scanning] tab of the "ScanSnap Setup Window" (page 45)

1 cm (0.39 in.) 5 mm (0.2 in.)

1 2 3 4 5 6

or More or Less

HINT
l Up to five fingers on each side (top/bottom/right/left) of the document can be filled in.
l To prevent image deterioration, select and fill in as many fingers as possible in one go.

1. On the window that appears after a document is scanned, select [Flat
document] and click the [Check/Correct] button.
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For details about scanning, refer to "Scanning a Document" (page 18).

a The [ScanSnap Manager - View cropped images] window is displayed.

2. Select a scanned image to fill in fingers captured in the image.

3. Select the [Continue with Point Retouch] checkbox and click the [Next]
button.

HINT
The orientation of the scanned image and the crop area cannot be corrected in the [ScanSnap
Manager - Book Image Viewer] window. Modify them in the [ScanSnap Manager - View cropped
images] window beforehand.
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a The [ScanSnap Manager - Book Image Viewer] window appears in the point retouch mode.

4. Click on a finger captured in a scanned image with the mouse.
a When a finger is detected, it is indicated with a red dashed outline.

To change a range of the outline, drag the white dot on the outline.
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HINT
When a finger captured in a scanned image is not detected, a default outline is displayed
around the finger.
In that case, drag the white dot on the outline to align the outline with the shape of the finger.

5. Click the [Apply] button.
a The finger captured in a scanned image is filled in.

When you have completed filling in the captured finger, click the [Save and Quit] button.
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Scanning Books

The book image correction allows you to correct scanned images.

The book image correction refers to making the following corrections to the images scanned from
books with the ScanSnap:

l "Correcting Distorted Book Images" (page 95)

l "Splitting a Double-Page Spread Image into Two Page Images" (page 100)

l "Filling in Fingers Captured in a Scanned Image (When a Book Is Scanned)" (page 103)
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Correcting Distorted Book Images

To correct the distortion of a scanned image from a book, follow the procedure below.

ATTENTION
l To correct the distortion of a scanned image, the shape of the book needs to be detected.

If a book is scanned as follows, the shape of the book may not be detected correctly.
- When a book to be scanned is held down outside of the appropriate areas (Figure 1)
- When a book is scanned without the Background Pad (Figure 2)
- When a book to be scanned is spread open and is placed face-down (Figure 3)
- When a book to be scanned is placed in a vertical orientation (Figure 4)
- When a book that is not rectangular or square is scanned (Figure 5)
- When a book that has a background color other than white (such as a comic magazine) is

scanned (Figure 6)
- When a book that has a narrow margin space (such as a catalogue or a magazine) is scanned

(Figure 7)
- When a book that is smaller than A5 size (148 × 210 mm/5.83 × 8.27 in.) in a double-page

spread is scanned (Figure 8)

1

5 6 7 8

2 3 4

l Follow the procedure below to perform multiple book image correction for one page.

1. Edit in book image correction mode ( ).
- Correcting a distorted book image
- Splitting a double-page spread image
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2. Edit in point retouch mode ( ).
- Filling in the captured fingers in image

If you edit in the book image correction mode after editing in the point retouch mode, the edited
results in point retouch mode are overridden.

1. On the window that appears after a book is scanned, select [Double-page
spread (Book/Magazine)] and click the [Check/Correct] button.
For details about scanning a book, refer to "Scanning a Book" (page 23).

a The [ScanSnap Manager - Book Image Viewer] window appears.

2. Select the page to correct the distortion.

3. Click .
a The shape of the book is automatically detected, and the following items are displayed on

the page:

l Corner points

Corner points are displayed around the corners of the book and both ends of the gutter.

l Outline

The shape of the book is indicated with a red dashed outline.

HINT

For the output format selection button, select .

4. On the page, drag the corner points to move the corners of the book and
both ends of the gutter to any location.
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On the front and back cover of the book, make the middle outline for the gutter parallel to the
right and left outlines.

If the outline of the book is not aligned with the shape of the book in the scanned image, drag
the upper part and lower part of the outline to correct each position.

HINT
If the shape of the book was not detected, the corner points and the outline are displayed on the
entire window.
If this is the case, align the corner points and the outline with the shape of the book.
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Follow the procedure below to modify the corner points and the outline.
1. Modify the corner points.

The corner points can be modified by either of the following:
l Double-click the position where you want to move the corner points.

a The corner points automatically move to the double-clicked position.
If the corner points cannot be modified properly, drag them to move.

l Drag the corner points to desired positions.
Modify the corner points at both ends of the gutter first and then the corners of the book.

2. Modify the outline.
Drag the outline to align it with the shape of the book. If it is hard to align the outline with the
shape of the book, position the outline little by little.
To make it easy, click an outline near the corner points and drag and drop the outline to align
it with the shape of the book repeatedly.

5. Click the [Apply] button.
a A message for confirming the correction target appears.

6. Click the [Selected Pages] button.
a The page distortion is corrected.

When you have completed correcting the page distortion, click the [Save and Quit] button.

HINT
l To correct another distorted page, select the page for which the distortion is to be corrected

in [Final image], and repeat steps 2 to 6.
l When the text, lines, or graphics in the scanned image are horizontally skewed, clear the

[Correct skewed text] check box.
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When there are curved/slanted lines or graphics with curved/slanted lines on the document,
the scanned image of the document may not be corrected properly and the layout may not
look right.
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Splitting a Double-Page Spread Image into Two Page Images

The double-page spread image can be split into the right and left pages.

When a JPEG file is split, the file is divided into two files.

1
2

1
2

ATTENTION
Follow the procedure below to perform multiple book image correction for one page.

1. Edit in book image correction mode ( ).
l Correcting a distorted book image
l Splitting a double-page spread image

2. Edit in point retouch mode ( ).
l Filling in the captured fingers in image

If you edit in the book image correction mode after editing in the point retouch mode, the edited results
in point retouch mode are overridden.

1. On the window that appears after a book is scanned, select [Double-page
spread (Book/Magazine)] and click the [Check/Correct] button.
For details about scanning a book, refer to "Scanning a Book" (page 23).
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a The [ScanSnap Manager - Book Image Viewer] window appears.

2. Select the page to be split.

3. Click , and then click  or .
a The split line is indicated with a green dashed line.

If the split line is not aligned with the gutter of the book, drag the corner points to correct the
position.

4. Click the [Apply] button.
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a A message for confirming the split target appears.

5. Click the [Selected Pages] button.
a The page is split.

When you have completed splitting the page, click the [Save and Quit] button.

Scanning Books

102



Filling in Fingers Captured in a Scanned Image (When a Book Is
Scanned)

Fingers that are captured when a book is scanned can be filled in.

ATTENTION
l To fill in fingers captured in the scanned image, the fingers need to be detected.

If a book is scanned in the following ways, captured fingers may not be detected correctly.
- When two or more fingers that are used to hold down a book to be scanned are touching each

other (Figure 1)
- When you hold down a book to be scanned with manicured fingers or fingers with artificial nails

(Figure 2)
- When you hold down a book to be scanned with your fingers bent (Figure 3)
- When fingers that are used to hold down a book to be scanned are captured 1 cm (0.39 in.) or

more (Figure 4)
- When there is text or an image within 5 mm (0.2 in.) around the fingers that are used to hold

down a book to be scanned (Figure 5)
- When a book that has a background color other than white (such as a comic magazine) is

scanned (Figure 6)
- When a book is scanned after [Gray] or [B&W] is selected from the [Color mode] drop-down list

in the [Scanning] tab of the "ScanSnap Setup Window" (page 45)

1 cm (0.39 in.) 5 mm (0.2 in.)

1 2 3 4 5 6

or More or Less

l Follow the procedure below to perform multiple book image correction for one page.

1. Edit in book image correction mode ( ).
- Correcting a distorted book image
- Splitting a double-page spread image

2. Edit in point retouch mode ( ).
- Filling in the captured fingers in image
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If you edit in the book image correction mode after editing in the point retouch mode, the edited
results in point retouch mode are overridden.

HINT
l Up to five fingers on each side (right/left) can be filled in.
l To prevent image deterioration, select and fill in as many fingers as possible in one go.

1. On the window that appears after a book is scanned, select [Double-page
spread (Book/Magazine)] and click the [Check/Correct] button.
For details about scanning a book, refer to "Scanning a Book" (page 23).

a The [ScanSnap Manager - Book Image Viewer] window appears.

2. Select the page for filling in captured fingers.

3. Click .

4. Click on a finger captured in a scanned image with the mouse.
a When a finger is detected, it is indicated with a red dashed outline.

To change a range of the outline, drag the white dot on the outline.
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HINT
When a finger captured in a scanned image is not detected, a default outline is displayed
around the finger.
In that case, drag the white dot on the outline to align the outline with the shape of the finger.

5. Click the [Apply] button.
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a The finger captured in a scanned image is filled in.

When you have completed filling in the captured finger, click the [Save and Quit] button.
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Scanning Multiple Documents at Once

When multiple documents are scanned at once with the ScanSnap, the following corrections can be
made on the scanned images:

l "Correcting the Scanned Image Orientation" (page 108)

l "Modifying the Crop Area" (page 111)

l "Adding the Necessary Scanned Images" (page 113)

l "Deleting Unnecessary Scanned Images" (page 115)
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Correcting the Scanned Image Orientation

The orientation of scanned images that are skewed or upside-down can be corrected.

1. On the window that appears after multiple documents are scanned at once,
select [Flat document] and click the [Check/Correct] button.
For details about scanning multiple documents, refer to "Scanning Multiple Documents at
Once" (page 28).

a The [ScanSnap Manager - View cropped images] window is displayed.

2. Select which scanned image to correct the orientation for.
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3. Click  or .
a The scanned image is rotated by 90 degrees.

When you have completed correcting the orientation, click the [Save and Quit] button.
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HINT
l To fine-tune the orientation of the crop frame, select which scanned image you want to rotate and

then perform one of the following operations:
- Drag the green operating point that appears at the top of the crop frame by as little or as much

as you want.

- Click  or .
l If the [Next] button is displayed, clear the [Continue with Point Retouch] checkbox. The [Next]

button changes to the [Save and Quit] button.
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Modifying the Crop Area

The size of the crop frame that is used to crop the scanned image can be modified.

1. On the window that appears after multiple documents are scanned at once,
select [Flat document] and click the [Check/Correct] button.
For details about scanning multiple documents, refer to "Scanning Multiple Documents at
Once" (page 28).

a The [ScanSnap Manager - View cropped images] window is displayed.

2. Select the crop area of the scanned image to change the crop area.

3. Drag the operating points of the crop frame to change the crop area.
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4. Click any position on the window.
a The crop area is fixed.

When you have completed changing the crop area, click the [Save and Quit] button.

HINT
l To move a crop frame, place the mouse inside the crop frame and drag it when all the operating

points have turned red.
l If the [Next] button is displayed, clear the [Continue with Point Retouch] checkbox. The [Next]

button changes to the [Save and Quit] button.
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Adding the Necessary Scanned Images

If the necessary scanned images do not become the targets to be cropped, you can manually add
them to the targets.

Up to 20 crop frames can be added for one scanned image.

1. On the window that appears after multiple documents are scanned at once,
select [Flat document] and click the [Check/Correct] button.
For details about scanning multiple documents, refer to "Scanning Multiple Documents at
Once" (page 28).

a The [ScanSnap Manager - View cropped images] window is displayed.

2. Frame the scanned image to be cropped by dragging the mouse.
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a A crop frame is added to the scanned image that is automatically recognized, and the
scanned image that was cropped by dragging the mouse is added to the end of [Cropped
image].

After you have added a crop frame, click the [Save and Quit] button.

HINT
If the [Next] button is displayed, clear the [Continue with Point Retouch] checkbox. The [Next] button
changes to the [Save and Quit] button.
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Deleting Unnecessary Scanned Images

When there are multiple scanned images, unnecessary crop frames can be deleted.

Scanned images without crop frames are not output and cannot be linked with an application.

1. On the window that appears after multiple documents are scanned at once,
select [Flat document] and click the [Check/Correct] button.
For details about scanning multiple documents, refer to "Scanning Multiple Documents at
Once" (page 28).

a The [ScanSnap Manager - View cropped images] window is displayed.

2. Select a scanned image to remove the crop frame.
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3. Click .
a A confirmation message appears.

4. Click the [Yes] button.
a The crop frame is removed from the selected scanned image, and the scanned image

disappears from [Cropped image].
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After you have removed the crop frame from the unnecessary scanned image, click the
[Save and Quit] button.

HINT
If the [Next] button is displayed, clear the [Continue with Point Retouch] checkbox. The [Next] button
changes to the [Save and Quit] button.
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Troubleshooting

This section explains how to solve troubles you may encounter upon installing the software related
to the ScanSnap.

l "If You Have Installed the Software Before" (page 119)

l "When the ScanSnap Manager Icon Does Not Appear" (page 120)

l "When ScanSnap Manager Does Not Operate Normally" (page 122)

For details about the troubles you may encounter and the solutions while using the ScanSnap, refer
to the following:

l "Troubleshooting" in the ScanSnap Manager Help

To display this section, click the ScanSnap Manager icon  in the Dock while holding down
the [control] key on the keyboard, and select [Help] → [Troubleshooting] from the "ScanSnap
Manager Menu" (page 42).

l ScanSnap Support Site (http://scansnap.fujitsu.com/g-support/en/)

If you cannot solve the problem after referring to the above section, contact your FUJITSU scanner
dealer or an authorized FUJITSU scanner service provider.
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If You Have Installed the Software Before

If your attempt to reinstall the software related to the ScanSnap (including models other than SV600)
failed, uninstall the software and then reinstall it.

For details, refer to the following:

l "Uninstalling the Software" (page 131)

l "How to Install the Software" (page 40)
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When the ScanSnap Manager Icon Does Not Appear

This section explains how to troubleshoot when the ScanSnap Manager icon  does not appear
in the Dock even though the software is installed and the ScanSnap is connected to the computer.

l "Displaying the ScanSnap Manager Icon" (page 121)
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Displaying the ScanSnap Manager Icon

1. From the sidebar in Finder, select [Applications] → [ScanSnap], and then
double-click [ScanSnap Manager] to start ScanSnap Manager.

HINT
If the problem is solved, you can change the setting so that ScanSnap Manager will start up
automatically from the next time you log in to the computer.
The procedure is as follows.

l On the [System Preferences] window displayed from the Apple ( ) menu, select [Users &

Groups] → [Current User] → [Login Items] → [ ] → [ScanSnap] → [ScanSnap Manager].

l Click the ScanSnap Manager icon  in the Dock while holding down the [control] key on
the keyboard, and then select [Options] → [Open at Login] from the displayed menu.

If the problem persists, refer to "When ScanSnap Manager Does Not Operate Normally" (page 122).
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When ScanSnap Manager Does Not Operate
Normally

If the ScanSnap Manager icon in the Dock is displayed as  even though the software is
installed and the ScanSnap is connected to the computer, perform the following procedures.

l "Checking the Connection between the ScanSnap and the Computer" (page 123)

l "Checking If ScanSnap Manager Is Operating Normally" (page 124)
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Checking the Connection between the ScanSnap and the
Computer

1. Unplug the USB cable from the computer and the ScanSnap, then plug it
back in.
Make sure to leave at least 5 seconds between unplugging and plugging the cable.

If you are using a USB hub, connect the USB cable to the computer directly.

If the problem persists, refer to "Checking If ScanSnap Manager Is Operating Normally" (page 124).
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Checking If ScanSnap Manager Is Operating Normally

1. Turn off the ScanSnap and then turn it on again.
Make sure to leave at least 5 seconds between turning off and on the ScanSnap.

If the problem persists, proceed to step 2.

2. If you are using a USB hub, connect the ScanSnap to the computer directly
with a USB cable.

If the problem persists, proceed to step 3.

3. Turn off the ScanSnap and restart the computer.

If the problem persists, refer to "If You Have Installed the Software Before" (page 119). If the problem still persists,
perform the procedures described in "When ScanSnap Manager Does Not Operate Normally" (page 122) once
again.
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Cleaning

This section explains about the cleaning materials and how to clean the ScanSnap.

l "Cleaning Materials" (page 126)

l "Cleaning the ScanSnap" (page 127)
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Cleaning Materials

Cleaning materials and their part numbers are as below.

Product Name Part No. Unit Note

Cleaner F1 PA03950-0352 1 bottle Size: 100 ml

Cleaning Paper (*1) CA99501-0012 1 pack 10 sheets

Cleaning Wipe (*2) PA03950-0419 1 pack 24 packets

Lint-free dry cloth (*3) Commercially
available

- -

Cotton swabs Commercially
available

- Used to clean small parts such
as the camera or infrared LED.

*1: Used with Cleaner F1.

*2: The cleaning wipes are wet tissues that have been soaked with Cleaner F1. In place of this
product, you can use a cloth soaked with Cleaner F1.

*3: Any lint-free cloth can be used.

Contact your FUJITSU scanner dealer or an authorized FUJITSU scanner service provider for
details about purchasing the cleaning materials.

For details, refer to the following web page:

http://scansnap.fujitsu.com/

Cleaning Materials
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Cleaning the ScanSnap

This section explains how to clean the outside of the ScanSnap.

If the white sheet, glass, camera, lamp, or infrared LED is dirty, errors may appear in the scanned
images. Whenever an error appears in a scanned image, clean the ScanSnap.

1. Unplug the cables from the ScanSnap.

2. Clean the outside of the ScanSnap with a dry cloth, or a cloth moistened with
Cleaner F1/a mild detergent.
Use a cotton swab to clean small parts such as the camera or infrared LED of the ScanSnap.

ATTENTION
l Never use paint thinner or any other organic solvents. The shape or color may be changed.
l When cleaning the ScanSnap, prevent liquids from entering the ScanSnap.
l It may take a long time for Cleaner F1 to dry if an excessive amount is used. Moisten the

cloth with moderate quantity. Wipe off the cleaner completely with a soft cloth to leave no
residue on the cleaned parts.

l When cleaning the ScanSnap, hold the neck of the ScanSnap with your hand to prevent it
from falling over.

Cleaner F1 or 
a Mild DetergentCloth

Lamps

Glass

White Sheets

Camera

Infrared LED
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Appendix

l "Preparations for Using Nuance PDF Converter for Mac" (page 129)

l "Updating the Software" (page 130)

l "Uninstalling the Software" (page 131)

l "Specifications of the Background Pad" (page 138)

l "Specifications of the ScanSnap" (page 139)
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Preparations for Using Nuance PDF Converter for
Mac

For details about the installation and activation methods of Nuance PDF Converter for Mac, refer to
the following web page:

How to Install PDF Editing Software
http://www.pfu.fujitsu.com/imaging/downloads/manual/install/en

Preparations for Using Nuance PDF Converter for Mac
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Updating the Software

Latest updates for ScanSnap related software are available for free from our download server. This
is called ScanSnap Online Update.

It is recommended that you apply latest updates to enhance security, operability and functions.

For the software programs that can be updated, refer to the following:

http://www.fujitsu.com/global/support/computing/peripheral/scanners/software/online-setup-help.html

ScanSnap Online Update checks the download server periodically.

When the latest version of ScanSnap is available, the update list window appears.

To install the update, follow the instructions on the window.

For details, refer to the ScanSnap Online Update Help.

You can also manually check from ScanSnap Manager whether a newer version of the program is
available and run the update.

1. Click the ScanSnap Manager icon  in the Dock while holding down the
[control] key on the keyboard, and click [Help] → [Online Update] from the
"ScanSnap Manager Menu" (page 42).
a ScanSnap Online Update checks whether a newer version of ScanSnap Manager is

available. Proceed with the update as you follow the instructions.

For details, refer to the ScanSnap Online Update Help.

ATTENTION
l To run the online update for ScanSnap Manager, you need to have access to the Internet.
l Log in as a user with Administrator privileges.

HINT
For details about updates of ScanSnap Manager, visit the following web pages:
http://scansnap.fujitsu.com/g-support/en/

Updating the Software
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Uninstalling the Software

This section explains how to uninstall the following software programs:

l "Uninstalling ScanSnap Manager" (page 132)

l "Uninstalling ScanSnap Organizer" (page 134)

l "Uninstalling CardMinder" (page 135)

l "Uninstalling ABBYY FineReader for ScanSnap" (page 136)

l "Uninstalling ScanSnap Online Update" (page 137)

Uninstalling the Software
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Uninstalling ScanSnap Manager

Uninstall ScanSnap Manager.

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. From the sidebar in Finder, select [Applications] → [ScanSnap] → [Sub], and
then double-click [ScanSnap Uninstaller].
a The [ScanSnap Uninstaller] window (the [Welcome to ScanSnap Uninstaller] screen)

appears.

3. Click the [Continue] button.
a The [Important Information] screen appears.

4. Read [Read Me], and then click the [Uninstall] button.
a The authentication window appears.

5. Enter the user name and password for a user with Administrator privileges,
and click the [OK] button.
a Uninstallation starts. When the uninstallation is complete, [Uninstall Succeeded] screen

appears.

6. Click the [Close] button.

HINT
When a user other than the user who uninstalled ScanSnap Manager has set ScanSnap
Manager as a login item, the following operations are required:
1. Log in as a user who has set ScanSnap Manager as a login item.

2. From the Apple ( ) menu, select [System Preferences].
a The [System Preferences] window appears.

3. Select [Users & Groups].
a The [Users & Groups] window appears.

4. From [Current User], select the currently logged-in user.

5. Select the [Login Items] tab.
a A list of login items appears.

6. From the list of login items, select [ScanSnap Manager].

7. Click the [ ] button under the list of login items.
a [ScanSnap Manager] is deleted from the list of login items.

Uninstalling the Software
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8. Close the [Users & Groups] window.
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Uninstalling ScanSnap Organizer

Uninstall ScanSnap Organizer.

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. Exit ScanSnap Organizer if it is running.

3. From the sidebar in Finder, select [Applications] → [ScanSnap Organizer],
and drag the [ScanSnap Organizer] folder into the Trash.

4. Empty the Trash.
a The [ScanSnap Organizer] folder is deleted.
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Uninstalling CardMinder

Uninstall CardMinder.

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. Exit CardMinder if it is running.

3. From the sidebar in Finder, select [Applications] → [CardMinder], and drag
the [CardMinder] folder into the Trash.

4. Empty the Trash.
a The [CardMinder] folder is deleted.

HINT
To delete the database, drag the database file into the Trash.
To access the database file stored in the default location, select [Documents] → [CardMinder] →
[CardMinder DB.cxdb] from the sidebar in Finder.
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Uninstalling ABBYY FineReader for ScanSnap

Uninstall ABBYY FineReader for ScanSnap.

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. Exit ABBYY FineReader for ScanSnap if it is running.

3. From the sidebar in Finder, select [Applications] → [ABBYY FineReader for
ScanSnap], and drag the [ABBYY FineReader for ScanSnap] folder into the
Trash.

4. Empty the Trash.
a The [ABBYY FineReader for ScanSnap] folder is deleted.

Uninstalling the Software

136



Uninstalling ScanSnap Online Update

Uninstall ScanSnap Online Update.

HINT
Before uninstalling ScanSnap Online Update, make sure that none of the following software is
installed.
l ScanSnap Manager
l ScanSnap Organizer
l CardMinder

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. From the sidebar in Finder, select [Applications] → [ScanSnap Online
Update] → [Sub], and then double-click [AOUUninstaller].
a The [ScanSnap Online Update Uninstaller] window ([Welcome to ScanSnap Online Update

Uninstaller]) appears.

3. Click the [Continue] button.
a The [Important Information] screen appears.

4. Read [Read Me], and then click the [Uninstall] button.
a The authentication window appears.

5. Enter the user name and password for a user with Administrator privileges,
and click the [OK] button.
a Uninstallation starts. When the uninstallation is complete, [Uninstall Succeeded] screen

appears.

Uninstalling the Software
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Specifications of the Background Pad

The product name and part number of the Background Pad are as follows.

Product Name Qty. Part No.

Background Pad 1 sheet PA03641-0052

Contact your FUJITSU scanner dealer or an authorized FUJITSU scanner service provider for
details about purchasing the Background Pad.

For details, refer to the following portal site:

http://scansnap.fujitsu.com/

Cleaning
As you keep using the Background Pad, dirt and dust will accumulate on the surface.

Clean the Background Pad with a dry or damp cloth.

ATTENTION
l Do not use any detergent.
l Keep the Background Pad away from fire or high-temperature objects.
l Do not wrinkle or fold the Background Pad.
l It is recommended that you store the Background Pad in the tube and bag in which the Background

Pad was packaged.
l Keep the Background Pad out of direct sunlight when storing it.

Specifications of the Background Pad
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Specifications of the ScanSnap

The following table summarizes the specifications of the ScanSnap.

Item Specification

Product Name ScanSnap SV600

Scanning method Overhead scanning

Scanning color mode Color/gray/black and white/auto (automatic color, gray, and
B&W detection)

Optical system/image sensor Lens reduction optics/color CCD × 1

Light source (White LED + lens illumination) × 2

Scanning speed (A3 landscape) 3 sec/sheet

Scan area Automatic detection (maximum), automatic detection (A4
landscape/letter landscape), A3 landscape, A4 landscape,
A5 landscape, A6 landscape, B4 landscape, B5 landscape,
B6 landscape, Post card landscape, Business card, Letter
landscape, Legal landscape, 11 × 17 in. landscape, custom
size (maximum: 432 × 300 mm/17.01 × 11.81 in., minimum:
25.4 × 25.4 mm/1.00 × 1.00 in.)

Magnification in vertical scanning (length) ±1.5%

Document thickness 30 mm (1.18 in.) or less

Interface USB 2.0/USB 1.1 (connector: B type) (*1)

Input power Voltage 100 to 240 V ±10%

Phase Single phase

Frequency range 50/60 Hz

Power consumption During operation: 20 W or less
During sleep mode: 2.6 W or less

Temperature/humidity
allowable ranges

Temperature During operation: 5 to 35 degrees C/41 to 95 degrees F
During standby: -20 to 60 degrees C/-4 to 140 degrees F
During storage/transportation: -20 to 60 degrees C/-4 to 140
degrees F

Humidity During operation: 20 to 80%
During standby: 8 to 95%
During storage/transportation: 8 to 95%

Outer dimensions (Width × Depth × Height) 210 × 156 × 383 mm/8.27 × 6.14 × 15.08 in.

Weight 3.0 kg (approx. 6.62 lb)

Environmental specification Compliant with the International Energy Star Program, and
RoHS Directive

Related Software Scanner driver ScanSnap Manager

File management ScanSnap Organizer

Business card
management

CardMinder

Text recognition ABBYY FineReader for ScanSnap

Update management and
application

ScanSnap Online Update

PDF editing Nuance PDF Converter for Mac

*1: When the ScanSnap is connected to a USB 3.0 port, the port operates as a USB 2.0 port.

Specifications of the ScanSnap
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Documents That Can Be Scanned with the
ScanSnap and How to Load Them (iX500,
S1500, S1500M, S1300i, S1300, or S1100)

This section describes the documents that can be scanned with the following ScanSnap models and
explains how to load the documents.

l iX500

l S1500

l S1500M

l S1300i

l S1300

l S1100

l "Documents for Scanning (For iX500, S1500 or S1500M)" (page 141)

l "How to Load Documents (For iX500, S1500 or S1500M)" (page 146)

l "Documents for Scanning (For S1300i or S1300)" (page 149)

l "How to Load Documents (For S1300i or S1300)" (page 151)

l "Documents for Scanning (For S1100)" (page 154)

l "How to Insert Documents (For S1100)" (page 159)

Documents That Can Be Scanned with the ScanSnap and How to Load Them (iX500, S1500, S1500M, S1300i, S1300, or S1100)
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Documents for Scanning (For iX500, S1500 or
S1500M)

This section explains about the documents that can be scanned with the ScanSnap and the
conditions for using the Carrier Sheet.

l "Conditions for Documents to Scan (For iX500, S1500 or S1500M)" (page 142)

l "Conditions for Using the Carrier Sheet (For iX500, S1500 or S1500M)" (page 144)

Documents for Scanning (For iX500, S1500 or S1500M)
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Conditions for Documents to Scan (For iX500, S1500 or S1500M)

iX500 S1500/S1500M

Document type Office paper, postcards, business cards
Plastic cards conforming to the ISO7810 ID-1
type (54 × 86 mm/2.1 × 3.4 in.)

Office paper, postcards, business cards

Paper weight 40 to 209 g/m2 (10.7 to 55.7 lb)
l Long page documents

52 to 127 g/m2 (13.9 to 33.9 lb)
l A8 size (52 × 72 mm) or less

127 to 209 g/m2 (33.9 to 55.7 lb)
l Plastic cards

0.76 mm (0.03 in.) or less (embossed cards
can be used)

52 to 127 g/m2 (13.9 to 33.9 lb)

Paper size Width: 50.8 to 216 mm (2 to 8.5 in.)
Length: 50.8 to 360 mm (2 to 14.17 in.)
l For long page (*1)

216 × 863 mm (8.5 × 34 in.)

*1: Scanning starts when you hold down the [Scan] button on the ScanSnap for 3 seconds or longer.

ATTENTION
l The following types of documents must not be scanned:

- Documents attached with the metals such as paper clips or staples that can damage the inside
of the ScanSnap
Remove the metals for scanning.

- Documents on which the ink is still wet
Wait until the ink dries completely to scan these documents.

- Documents larger than width 216 mm (8.5 in.), length 863 mm (34 in.)
- Documents other than paper such as fabric, metal foil and OHP film

l When you scan picture postcards, be aware that the picture side may get damaged. It is the
responsibility of the customer to scan picture postcards.

l When you scan plastic cards, in [Multifeed Detection] of the [Paper] tab of the "ScanSnap Setup
Window" (page 45), select [None] or [Check Length].

l Be careful of the following when you scan plastic cards:
- Cards that are bent may not be fed properly.
- If the surface of the card is dirty with grease marks such as fingerprints, perform scanning after

wiping the dirt off.
- When you scan plastic cards with strong luster, some parts of the image may appear lighter or

darker than the original.

Example: gold colored credit card
- When you scan embossed cards, put the embossed side down, and insert the card in

landscape orientation.
- If the embossed characters are not coated in gold or silver and the background color of the card

and the color of the embossed characters are similar, it may be difficult for the ScanSnap to
recognize embossed characters.
In which case, performing the following may result in an improvement.

Documents for Scanning (For iX500, S1500 or S1500M)
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1. Click the [Option] button in the [Scanning] tab of the "ScanSnap Setup Window" (page 45).
a The [Scanning mode option] window appears.

2. Select the [Increase text contrast] checkbox.

Documents for Scanning (For iX500, S1500 or S1500M)
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Conditions for Using the Carrier Sheet (For iX500, S1500 or
S1500M)

The bundled Carrier Sheet is a sheet designed to transport documents through the ScanSnap.

You can scan documents that are larger than A4/Letter size, photographs and clippings.

Conditions for documents that can be scanned using the Carrier Sheet are as follows:

�������
l Do not use a damaged Carrier Sheet. Otherwise, it may damage or cause

the ScanSnap to malfunction.

l Be careful not to cut your finger on the edge of the Carrier Sheet.
 

iX500 S1500/S1500M

Paper type Documents that cannot be loaded directly into the ScanSnap

Paper weight Up to 209 g/m2 (55.7 lb)
l When scanning documents folded in half:

Up to 104.5 g/m2 (27.9 lb)

Up to 127 g/m2 (34 lb)
l When scanning documents folded in half:

Up to 63.5 g/m2 (17 lb)

Paper size Carrier Sheet size (216 × 297 mm)
A3 (297 × 420 mm) (*1)
A4 (210 × 297 mm)
A5 (148 × 210 mm)
A6 (105 × 148 mm)
B4 (257 × 364 mm) (*1)
B5 (182 × 257 mm)
B6 (128 × 182 mm)
Postcard (100 × 148 mm)
Business card (90 × 55 mm, 55 × 90 mm)
Letter (8.5 × 11 in. (216 × 279.4 mm))
11 × 17 in. (279.4 × 431.8 mm) (*1)
l Custom size

Width: 25.4 to 216 mm (1 to 8.5 in.)
Length: 25.4 to 297 mm (1 to 11.69 in.)

*1: Fold in half to scan.

Documents for Which the Carrier Sheet is Recommended for
Scanning
It is recommended that you use the Carrier Sheet to scan the following documents.

l Documents written in pencil

Because there may be black traces left on the documents, it is recommended that you use the
Carrier Sheet to scan such documents.

When you scan such documents directly without using a Carrier Sheet, dirt will accumulate on
the rollers, which may cause feeding errors. Clean the rollers occasionally.

For details about how to perform cleaning, refer to "Troubleshooting" in the ScanSnap Manager
Help.

l Carbonless paper

Documents for Scanning (For iX500, S1500 or S1500M)
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Because carbonless paper may contain chemicals that can harm the ScanSnap internal rollers, it
is recommended that you use the Carrier Sheet to scan such documents.

Make sure to clean the rollers occasionally to maintain the scanner performance when scanning
carbonless paper directly without using the Carrier Sheet. For details about how to perform
cleaning, refer to "Troubleshooting" in the ScanSnap Manager Help.

Depending on the type of carbonless paper, the life span of the scanner may be shortened
compared to scanning office paper.

l Scanning the following types of documents without using the Carrier Sheet can result in
documents being damaged or scanned incorrectly

- Documents smaller than width 50.8 mm (2 in.), length 50.8 mm (2 in.)

- Documents that weigh less than the following paper weights:

iX500: 40 g/m2 (10.7 lb)

S1500/S1500M: 52 g/m2 (14 lb)

- Documents with an uneven surface (such as envelopes and paper sheets with attached
materials)

- Wrinkled or curled documents

- Folded or torn documents

- Tracing paper

- Coated paper

- Photographs (photographic paper)

- Perforated or punched documents

- Documents that are not rectangular or square

- Carbon paper or thermal paper

- Documents with memo papers or sticky notes attached

ATTENTION
l Using the Carrier Sheet

Be careful of the following when you use the Carrier Sheet:
- Do not stain, or cut the end with a black & white pattern. Otherwise, the Carrier Sheet will not be

recognized properly.
- Do not place the Carrier Sheet upside down. Otherwise, a paper jam may occur and damage

the Carrier Sheet and the document inside.
- Do not fold or pull the Carrier Sheet.
- Paper jams may occur when several small size documents such as photographs and postcards

are placed inside the Carrier Sheet to be scanned at once. It is recommended that you scan
such documents one at a time.

- If paper jams occur frequently, feed about 50 sheets of PPC paper (recycled paper) before
scanning with the Carrier Sheet. The PPC paper can either be blank or printed.

l Storing the Carrier Sheet
Be careful of the following when you store the Carrier Sheet:
- Do not leave your document inside the Carrier Sheet for a long time. Otherwise, the ink on the

document may be transferred onto the Carrier Sheet.
- To avoid deformation, do not use or leave the Carrier Sheet in high temperature places such as

under direct sunlight or near a heating apparatus for a long time.
- To avoid deformation, store the Carrier Sheet on a flat surface without any weight on it.
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How to Load Documents (For iX500, S1500 or
S1500M)

Load documents in the ScanSnap in the following procedure.

For details about documents that can be loaded, refer to "Documents for Scanning (For iX500,
S1500 or S1500M)" (page 141).

1. If you are loading multiple sheets, check the number of sheets.
The maximum number of sheets in the ScanSnap is as follows:

For A4 or smaller sizes: Up to 50 sheets can be loaded (with paper weight of 80 g/m2 [20 lb]
and thickness of the document stack under 5 mm [0.2 in.]).

ATTENTION
If you try to scan more than the maximum amount that can be loaded, the following problems
may occur:
l Files cannot be properly created due to excessive file size.
l Paper jams occur during scanning.

2. Fan the documents.
1. Hold both ends of the documents and fan them a few times.

2. Rotate the documents 90 degrees and fan them in the same manner.

3. Straighten the edges of the documents and slightly displace the top edges at
an angle.

BackAt an Angle

Feed Direction

ATTENTION
Paper jams or damage to documents may occur if you scan the documents without aligning the
edges first.
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4. Open the ADF paper chute (cover) of the ScanSnap.

ADF Paper Chute (Cover)

5. Pull the stacker towards you.

Stacker

6. Depending on documents to scan, pull out the extension on the ADF paper
chute (cover) and open the stacker.

Extension

Stacker

7. Load the documents in the ADF paper chute (cover).
Load the documents face-down and top-first with their back facing you. Use the reference
marks within the side guides to adjust the number of the documents to be loaded.

How to Load Documents (For iX500, S1500 or S1500M)
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Side Guide

ATTENTION
Do not accumulate more than 50 sheets (with paper weight of 80 g/m2 [20 lb]) in the stacker.

8. Adjust the side guides to the width of the documents.
Hold each side guide in the middle to adjust them. Otherwise, the documents may be fed
skewed.

Documents
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Documents for Scanning (For S1300i or S1300)

Office paper, postcards, business cards
S1300i/S1300

Document type Office paper, postcards, business cards

Paper weight 64 to 104.7 g/m2 (17 to 20 lb)

Paper size Width: 50.8 to 216 mm (2 to 8.5 in.)
Length: 50.8 to 360 mm (2 to 14.17 in.)
l For long page (*1)

216 × 863 mm (8.5 × 34 in.)

*1: Scanning starts when you hold down the [Scan] button on the ScanSnap for 3 seconds or longer.

ATTENTION
The following types of documents must not be scanned:
l Documents attached with the metals such as paper clips or staples that can damage the inside of

the ScanSnap
Remove the metals for scanning.

l Documents on which the ink is still wet
Wait until the ink dries completely to scan these documents.

l Documents larger than width 216 mm (8.5 in.), length 863 mm (34 in.)
l Documents other than paper such as fabric, metal foil, OHP film, or plastic card
l Documents with photographs or memo papers attached

Documents that you need to treat with caution
l Documents written in pencil

When you scan documents written in pencil, there may be black traces left on them. Also, dirt
accumulating on the rollers may cause feeding errors. Clean the rollers occasionally when you
scan such documents. For details about how to perform cleaning, refer to "Troubleshooting" in
the ScanSnap Manager Help.

l Carbonless paper

Carbonless paper may contain chemicals that can harm the pad assy and the pick roller inside
the ScanSnap. Make sure to perform cleaning occasionally to maintain the scanner
performance when scanning carbonless paper. For details about how to perform cleaning,
refer to "Troubleshooting" in the ScanSnap Manager Help. Depending on the type of
carbonless paper, the life span of the scanner may be shortened compared to scanning office
paper.

l Scanning the following types of documents can result in documents being damaged or
scanned incorrectly.

- Documents smaller than width 50.8 mm (2 in.), length 50.8 mm (2 in.)

- Documents that weigh less than 64 g/m2 (17 lb)

- Documents with an uneven surface (such as envelopes and paper sheets with attached
materials)

- Wrinkled or curled documents

- Folded or torn documents

- Tracing paper
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- Coated paper

- Photographs (photographic paper)

- Perforated or punched documents

- Documents that are not rectangular or square

- Carbon paper or thermal paper

- Documents with memo papers or sticky notes attached

Picture Postcards
Picture postcards can be scanned when a power cable connection is used.

S1300i/S1300

Document type Picture postcards

Paper weight 64 to 326 g/m2 (17 to 87 lb)

Paper size Width: 50.8 to 100 mm (2 to 3.9 in.)
Length: 50.8 to 148 mm (2 to 5.8 in.)

ATTENTION
l All conditions below must be satisfied when scanning picture postcards. Otherwise, paper jam may

occur.
- Power cable connection
- Normal room temperature and humidity levels
- Load the picture postcard face-down in the ScanSnap

l When you scan photographs or picture postcards, be aware that the picture side may get damaged.
It is the responsibility of the customer to scan photographs or picture postcards.

Documents for Scanning (For S1300i or S1300)

150



How to Load Documents (For S1300i or S1300)

Load documents in the ScanSnap in the following procedure.

For details about documents that can be loaded, refer to "Documents for Scanning (For S1300i or
S1300)" (page 149).

1. If you are loading multiple sheets, check the number of sheets.
The maximum number of sheets in the ScanSnap is as follows:

For A4 or smaller sizes: Up to 10 sheets can be loaded (with paper weight of 80 g/m2 [20 lb]
and thickness of the document stack under 1 mm [0.04 in.]).

ATTENTION
If you try to scan more than the maximum amount that can be loaded, the following problems
may occur:
l Files cannot be properly created due to excessive file size.
l Paper jams occur during scanning.

2. Fan the documents.
1. Hold both ends of the documents and fan them a few times.

2. Rotate the documents 90 degrees and fan them in the same manner.

3. Straighten the edges of the documents and slightly displace the top edges at
an angle.

BackAt an Angle

Feed Direction

ATTENTION
Paper jams or damage to documents may occur if you scan the documents without aligning the
edges first.

4. Open the ADF paper chute (cover) of the ScanSnap.
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ADF Paper Chute (Cover)

5. Pull out the extension.

Extension

6. Load the documents in the ADF paper chute (cover).
Load the documents face-down and top-first with their back facing you. Use the reference
marks within the side guides to adjust the number of the documents to be loaded.

Side Guide

7. Adjust the side guides to the width of the documents.
Hold each side guide in the middle to adjust them. Otherwise, the documents may be fed
skewed.
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Documents for Scanning (For S1100)

This section explains about the documents that can be scanned with the ScanSnap and the
conditions for using the Carrier Sheet.

l "Conditions for Documents to Scan (For S1100)" (page 155)

l "Conditions for Using the Carrier Sheet (For S1100)" (page 157)
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Conditions for Documents to Scan (For S1100)

S1100

Eject method With the output guide closed With the output guide open

Document type Office paper, postcards, business cards
Plastic cards conforming to the ISO7810 ID-1 type (54 ×
86 mm)

Office paper

Paper weight 52.3 to 209.3 g/m2 (14 to 56.1 lb)
l Plastic cards

0.76 mm (0.03 in.) (embossed cards can be used)

52.3 to 80 g/m2 (14 to 20 lb)

Paper size Width: 25.4 to 216 mm (1 to 8.5 in.)
Length: 25.4 to 360 mm (1 to 14.17 in.)
l For long page (*1)

216 × 863 mm (8.5 × 34 in.)

*1: Scanning starts when you hold down the [Scan/Stop] button on the ScanSnap for 3 seconds or
longer.

ATTENTION
l The following types of documents must not be scanned:

- Documents attached with the metals such as paper clips or staples that can damage the inside
of the ScanSnap
Remove the metals for scanning.

- Documents on which the ink is still wet
Wait until the ink dries completely to scan these documents.

- Documents smaller than width 216 mm (8.5 in.), length 863 mm (34 in.)
- Documents other than paper such as fabric, metal foil and OHP film

l When you scan picture postcards, be aware that the picture side may get damaged. It is the
responsibility of the customer to scan picture postcards.

l Be careful of the following when you scan plastic cards:
- Cards that are bent may not be fed properly.
- If the surface of the card is dirty with grease marks such as fingerprints, perform scanning after

wiping the dirt off.
- Insert the plastic card straight into the feeding section of the ScanSnap. Do not tilt the plastic

card when you insert it because the plastic card may not be fed properly.
- When you scan plastic cards with strong luster, some parts of the image may appear lighter or

darker than the original.

Example: gold colored credit card
- Insert embossed cards in landscape orientation to achieve better scanning results.
- If the embossed characters are not coated in gold or silver and the background color of the card

and the color of the embossed characters are similar, it may be difficult for the ScanSnap to
recognize embossed characters.
In which case, performing the following may result in an improvement.
1. Click the [Option] button in the [Scanning] tab of the "ScanSnap Setup Window" (page 45).

a The [Scanning mode option] window appears.
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2. Select the [Increase text contrast] checkbox.
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Conditions for Using the Carrier Sheet (For S1100)

The optional Carrier Sheet is a sheet designed to transport documents through the ScanSnap.

You can scan documents that are larger than A4/Letter size, photographs and clippings.

Conditions for documents that can be scanned using the Carrier Sheet are as follows:

�������
l Do not use a damaged Carrier Sheet. Otherwise, it may damage or cause

the ScanSnap to malfunction.

l Be careful not to cut your finger on the edge of the Carrier Sheet.
 

S1100

Eject method With the output guide closed

Document type Documents that cannot be loaded directly into the ScanSnap

Paper weight Up to 127 g/m2 (34 lb)
l When scanning documents folded in half:

Up to 63.5 g/m2 (17 lb)

Paper size Carrier Sheet size (216 × 297 mm)
A3 (297 × 420 mm) (*1)
A4 (210 × 297 mm)
A5 (148 × 210 mm)
A6 (105 × 148 mm)
B4 (257 × 364 mm) (*1)
B5 (182 × 257 mm)
B6 (128 × 182 mm)
Postcard (100 × 148 mm)
Business card (90 × 55 mm, 55 × 90 mm)
Letter (8.5 × 11 in. (216 × 279.4 mm))
11 × 17 in. (279.4 × 431.8 mm) (*1)
l Custom size

Width: 25.4 to 216 mm (1 to 8.5 in.)
Length: 25.4 to 297 mm (1 to 11.69 in.)

*1: Fold in half to scan.

Documents for Which the Carrier Sheet is Recommended for
Scanning
It is recommended that you use the Carrier Sheet to scan the following documents.

l Documents written in pencil

Because there may be black traces left on the documents, it is recommended that you use the
Carrier Sheet to scan such documents.

When you scan such documents directly without using a Carrier Sheet, dirt will accumulate on
the rollers, which may cause feeding errors. Clean the rollers occasionally.

For details about how to perform cleaning, refer to "Troubleshooting" in the ScanSnap Manager
Help.

l Carbonless paper
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Because carbonless paper may contain chemicals that can harm the ScanSnap internal rollers, it
is recommended that you use the Carrier Sheet to scan such documents.

Make sure to clean the rollers occasionally to maintain the scanner performance when scanning
carbonless paper directly without using the Carrier Sheet. For details about how to perform
cleaning, refer to "Troubleshooting" in the ScanSnap Manager Help.

Depending on the type of carbonless paper, the life span of the scanner may be shortened
compared to scanning office paper.

l Scanning the following types of documents without using the Carrier Sheet can result in
documents being damaged or scanned incorrectly

- Documents smaller than width 25.4 mm (1 in.), length 25.4 mm (1 in.)

- Documents that weigh less than 52.3 g/m2 (14 lb)

- Documents with an uneven surface (such as envelopes and paper sheets with attached
materials)

- Wrinkled or curled documents

- Folded or torn documents

- Tracing paper

- Coated paper

- Photographs (photographic paper)

- Perforated or punched documents

- Documents that are not rectangular or square

- Carbon paper or thermal paper

- Documents with memo papers or sticky notes attached

ATTENTION
l Using the Carrier Sheet

Be careful of the following when you use the Carrier Sheet:
- Do not stain, or cut the end with a black & white pattern. Otherwise, the Carrier Sheet will not be

recognized properly.
- Do not place the Carrier Sheet upside down. Otherwise, a paper jam may occur and damage

the Carrier Sheet and the document inside.
- Do not fold or pull the Carrier Sheet.
- Paper jams may occur when several small size documents such as photographs and postcards

are placed inside the Carrier Sheet to be scanned at once. It is recommended that you scan
such documents one at a time.

l Storing the Carrier Sheet
Be careful of the following when you store the Carrier Sheet:
- Do not leave your document inside the Carrier Sheet for a long time. Otherwise, the ink on the

document may be transferred onto the Carrier Sheet.
- Do not leave the Carrier Sheet in high temperature places such as under direct sunlight or near

devices that generate heat for a long time. Also, do not use it in high temperature places.
Otherwise, the Carrier Sheet may deform.

- To avoid deformation, store the Carrier Sheet on a flat surface without any weight on it.
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How to Insert Documents (For S1100)

Insert documents in the ScanSnap in the following procedure.

For details about documents that can be inserted, refer to "Documents for Scanning (For S1100)"
(page 154).

ATTENTION
You can only insert one document at a time in the ScanSnap.

1. Open the feed guide of the ScanSnap.

Feed Guide

HINT
l If you want the document to be ejected from the front of the ScanSnap or when there is not

enough space where the document exits the ScanSnap, open the output guide.
For details about documents that can be scanned with the output guide open, refer to
"Documents for Scanning (For S1100)" (page 154).

Output Guide

l How the document is ejected differs as below depending on whether the output guide is open
or closed.
- With the output guide closed

- With the output guide open

a The [Scan/Stop] button flashes in blue. The button returns to being lit normally when
document scanning is enabled.
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In addition, the ScanSnap Manager icon in the Dock changes from  to .

2. Insert the document straight into the feeding section of the ScanSnap, with
the scanning side facing up.

a The document is pulled in until it is set inside the ScanSnap.

ATTENTION
l When you select an option other than [Automatic detection] for [Paper size] on the [Paper]

tab in the "ScanSnap Setup Window" (page 45), insert the document by aligning it with the
left edge of the feeding section.

l When you perform scanning with the output guide closed, leave enough space at the back of
the ScanSnap to allow the document to be completely ejected.
Make sure that the area where the document exits the scanner is clear of any obstacles.
Otherwise, paper jam may occur.

l If you scan the following documents with the output guide open, a paper jam may occur and
damage the documents. Scan the following documents with the output guide closed.

- Thick paper (80 g/m2 [20 lb] or heavier)
- Postcards
- Business cards
- Plastic cards
- Carrier Sheet

Output Guide
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About Customer Support and Maintenance

Customer Support
l ABBYY FineReader for ScanSnap

From the sidebar in Finder, select [Applications] → [ABBYY FineReader for ScanSnap] →
[ABBYY FineReader for ScanSnap] → [Help] → [ABBYY FineReader for ScanSnap Help] →
[Technical Support].

l Evernote

Refer to the following web page:

http://www.evernote.com/about/contact/support/

l Google Drive

Refer to the Google Drive Help Center or the Google Product Forums.

To open them, select [Help] in Google Drive.

l Salesforce

Contact the system administrator of your Salesforce.

l Dropbox

Refer to the following web page:

http://www.dropbox.com/contact

l ScanSnap

For other inquiries on the ScanSnap, refer to the ScanSnap Support Site.

http://scansnap.fujitsu.com/g-support/en/

If your problem cannot be solved after referring to the above web pages, visit the following web
page to check the contact information of a suitable Fujitsu office and contact the Fujitsu office.

http://imagescanner.fujitsu.com/warranty.html

Suppliers of Consumables/Optional Parts
http://scansnap.fujitsu.com/

Maintenance
Contact your FUJITSU scanner dealer or an authorized FUJITSU scanner service provider for
repairs on this product.

For details, refer to the following portal site:

http://imagescanner.fujitsu.com/warranty.html

ATTENTION
For safety reasons, never attempt repairs by yourself.
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